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HOW TO USE THIS MANUAL

Conventions used in this publication. The focus of this document is on providing general
information to those who are not AFATDS operators, but are involved in Fire Support. It is not
procedure oriented. However, more details and limited procedures may be found in the
appendices.



TB 11-7025-297-10

ABSTRACT

AFATDS (Advanced Field Artillery Tactical Data System) is a tool. This tool fills the automated
C3 (Command Control and Communications) system role for the fires battlefield functional area.
It assists in managing operational and tactical fires in support of the maneuver as well as provide
technical control of firing elements. It provides the commander with integrated, responsive, and
reliable fire support. AFATDS is a fully automated fire support system, which minimizes the
sensor-to-shooter timeline and increases the hit ratio. It provides fully automated support for
planning, coordinating and controlling mortars, field artillery cannons, rockets, guided missiles,
close air support, attack helicopter and naval gunfire, for close support, counterfire, interdiction,
and deep operations. The system is used at all echelons from the platoon operations center to
the corps fire support element. It operates with all existing and planned US fire support systems
as well as allied field artillery C3 systems such as ADLER, ATLAS and BATES. AFATDS runs on
the Sun Solaris operating system. AFATDS is written primarily using ADA programming
language but also contains a large number of Java and C++ components.
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AFATDS OVERVIEW

Introduction

The Advanced Field Artillery Tactical
Data System (AFATDS) is a tool. Just
as a hammer makes putting nails in a
board a lot easier than pounding them in
with your fist, so AFATDS makes Fire
Support a lot easier to accomplish.
AFATDS is a fully automated Command
& Control (C2) system that prioritizes
targets and pairs them with optimal Fire
Support weapon systems. It gives
commanders timely, accurate,
coordinated fire support to prosecute
high-value targets. This is enhanced by
color-coded missions status, unit status,
and map displays for ease of use.

Although it is highly automated, AFATDS
allows for human intervention, whenever
necessary. The system does not force
current doctrine, but supports it.
Commanders’ Guidance is factored into
each mission. Options and
recommendations are given to the
operator for each mission processed,
based on rule sets input by the operator.
Tailorable rule sets are available for
target processing, weapon pairing,
information distribution, and
communications redundancy.

Unit relationships may also be tailored in
real time to adapt to changing needs.
The system provides agility, allowing for
the establishment of the sensor to
shooter link while ensuring mission
coordination needs are considered.
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Fire Support Areas Which AFATDS Supports

1. Fire Support Planning. Fire Support Planning
provides integration of field artillery, mortars, naval
surface fire support, aviation (helicopters), and air
support into the Force Commander's scheme of
maneuver. AFATDS helps create a Fire Support
annex to the commander’s Operation Plan
(OPLAN) and a Field Artillery Support Plan.

2. Fire Support Execution. Fire Support Execution
is guided by fire support and field artillery support
plans. It performs sensor employment, target
processing, attack systems analysis, technical fire
direction for cannon units, tactical fire control for
MLRS units, and target damage assessment.

3. Movement Control. Movement Control
manages and coordinates the movement of field

artillery units and sensors and coordinates the
movement of fire support units and sensors.

4. Field Artillery Mission Support. Field Artillery
Mission Support includes functions logistically
supporting the field artillery system. It creates and
maintains supply inventory files, supply requests,
and supply reports.

5. Field Artillery Fire Direction Operations. Field
Artillery Fire Direction Operations includes the
collection and maintenance of weapon, fire unit,
and ammunition status data required for day-to-
day operations. This information is provided in
either detailed or aggregate form to appropriate
Operations Centers in support of both planning
and execution requirements.

AFATDS and the Map software, which the system uses, provide critical Situation Awareness
(SA). Both friendly and enemy unit graphics are displayed, along with target information from
multiple sources. Due to the multi-level communications across the network, unit status, and
weapon platforms are monitored and updated continually on the map. Unit information may be
directly accessed from the map symbols. Friendly units, enemy units, targets, and areas of
responsibility can all be seen. At each AFATDS box, the operator may filter the information to be
displayed, thus allowing the commander to monitor the dynamic current situation, missions
processing through the system, and target updates from his needed perspective.
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AFATDS Communications

Figure 1, AFATDS is not limited to Field Artillery communications, but can communicate with Air
Force, Marine, Navy, and NATO systems. AFATDS is interoperable with all fires subsystems
including GDU, AFCS, FCS, Firefinder Radar, ATHS, and FOS. It interoperates with the Army
Battle Command Systems (ABCS) suite including ASAS, MCS, FAADC2I, and CSSCS. The
system also interoperates with Joint level automated systems such as CTAPS, TBMCS, JSTARS,
GCS, and JMCIS. AFATDS also interoperates with BATES, ADLER, and ATLAS, which are
NATO systems

AFATDS communicates around the battlefield using the programmable Tactical Communication
Interface Module (TCIM) or the SPTCIM. This enables the communication over Wire (2W/4W),
Combat Net Radio (CNR), Mobile Subscriber Equipment (MSE), and the Enhanced Position
Location and Reporting System (EPLRS). The system also uses a Network Interfaced Card to
talk over LAN for SIPRNET/NIPRNET operations.

1.3

Weapon Systems
Cannon (BCS)
Mortar (MBC)

MLRS (FDS) Tactical Exploitation
Paladin (AFCS : I >
MLRS rEF(CS) ) System (TES)

C2 Systems
IFSAS

Weather
MET System (MDS, MMS)

USMC Systems USAF Systems

Legacy FS Systems JVMF Systems Naval Systems
(Army & USMC) SaneerS NFCS
GCCS-M
PK10 & PK11 VMF glfiZklook Army Battle Command System
Sensors
FOs (FOS, FED, DMD, DCT) EE VS
FIST (FIST DMD) Paladin
JSTARS GSM C2 Systems
Airborne (ATHS) Weather
Firefinder (Q36/37/Q47) Maneuver (FBCB?2 et al)

ATO Systems

. SIR

BATES

I

/

Communications

Combat Net Radio: SINCGARS*, VHF, HF
Army Data Distribution System: EPLRS*
Area Common User System: MSE, TRFTAC, SATCOM

I0S/GCCS-M via CTAPS
JMCIS LAN TBMCS
Local Area Network (Internal, external LAN)

Wire Line

*Uses TCIM or INC as modem

Figure 1. Communications Interoperability

AFATDS Planning

The planning function within AFATDS allows for detailed planning and Course of Action (COA)
analysis by projecting friendly and enemy positions, guidance specific to the plan, and a task
organization for the plan. In order to assist with the planning function, an enemy template tool is
provided. A system tool supports multi-phase maneuver COAs and can compare and
recommend the best COA considering commander’s priorities. Plans can be easily disseminated.
The planning activity does not affect the current situation until the operator implements the plan.
Plans are implemented into current by phase - this immediately updates the UTO, guidance,
geometry, and target database to reflect changes.
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Target Analysis and Engagement

Target Analysis and Engagement is a very robust aspect of AFATDS as shown in the automated
assistance in target list management which allows for copy and merge functions, target
duplication checks, sorting, searching, and target data reception and transmission. Schedule of
fires may be calculated. There is an extensive set of targeting guidance that can be applied
(Target Selection Standards, High Payoff Targets, Decay time, target prioritization etc). From
intelligence reports and directional information, targets can be automatically generated. Pre-
planned missions can be linked to sensor reports for time sensitive targeting.

The system can deal with many weapons and pair those weapons to targets, minimizing the
timeline for the sensor to shooter thread. The system can filter sensor reports so that every
report doesn’t have to be engaged, and the system also selects the best weapon and munition
based on Target parameters (environment, countermeasures, TLE, age etc.), the munitions
required (effects capability, hazard area etc.), and weapon status (response time, current mission
load, ammunition inventory etc.).

Managing missions from start to finish, the system can handle 720 sensor inputs per hour.
Processing sensor inputs, the system considers mission value, not first in - first out. As the
system processes sensor data, it applies Target Selection Standards (TSS) and Commander’s
targeting guidance. This filters low value targets. The system analyzes cannon, mortar, rocket,
ATACMS, fixed & rotary wing air, naval cannon, standard missile & tomahawk as possibilities for
weapons. It coordinates ground and airspace violations, (spatial coordination is 4D, including
time analysis), is fully automatic and keeps interested nodes appraised of targeting information.
The system considers commanders’ guidance, latest unit status, mission history, and effects
algorithms, which determine munition quantity for both smart and conventional munitions. During
the mission processing, the operator may view and tailor the system recommendation. The
intervention display shows all key data and analysis results.
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THE AFATDS SOFTWARE PACKAGE

AFATDS Software and Operating System

The AFATDS software loads CD ROMs automatically, configure and load AFATDS software, as
well as loading all necessary components of the operating system and supporting programs. The
load process requires no operator interaction aside from providing the IP address and hostname
for the computer’s permanent LAN. The AFATDS software load is unclassified when loaded.
Adding munitions effectiveness data and operational information may require the operator to first
upgrade the security classification but this is not required to operate the system. The
components of the software load are as follows:

AFATDS operates on the Sun Solaris operating system (Version 8 2002). Solaris is a form of
UNIX OS (operating system). UNIX is used because it offers a stable OS that is less prone to
intrusion from external sources.

The AFATDS operator requires no knowledge of the operating system since all OS setup is either
automatically accomplished at software loading or during the AFATDS software’s configuration of
network interface based on operator inputs on windows provided.

The Common Operating Environment (COE)

The Common Operating Environment (COE) is software that provides a desktop and services for
AFATDS and other programs. It is designed to cut program costs by providing a core of common
services. It is also designed to make life easier for operators by giving the same look and feel
across multiple programs.

AFATDS application software: AFATDS application software interacts with the Solaris
OS and COE to provide fire support and fire direction capabilities.

As with a lot of the software, which gets loaded on a computer, loading AFATDS
provides a number of additional programs such as:

Star Office: a Sun office product providing word processing, presentation and
spreadsheet capabilities. Star office can use and save documents in MS Office formats.

Snapshot: provides screen capture capability.

NATO Ballistics Kernal (NABK): government provided ballistic computation segment
that provides computational support for cannon technical fire direction.

Maps
Sending Map Information

In communicating with other systems, AFATDS sends grids in LATLong and the other system
converts it. Also AFATDS only displays map locations in WGS -84 format because the JMTK
mapping software only supports the WGS-84 Datum. For example, the unit that wants to use the
NAD 1927 must ensure it sets up its Map datum in the map setup screen with that (NAD 1927)
Datum. That way, when it uses a map or receives locations from other sources using a map with
the NAD 1927 datum, the conversion will work correctly.

AFATDS actually stores all the location information in LatLong since Datums are not used in its
database. The system sends to the User (HI interface -Screens) or external sources in the format
(UTM, MGRS) requested or in the message format from the other system.

AFATDS passes LatLong between the other AFATDS OPFACSs. The external systems (non-
AFATDS) should use LAT LONG to pass the data except for PKG 10 message based systems. If
the system is communicating with another system still using PKG10 systems, the AFATDS
operator must ensure he sets up that unit information for whatever Datum they are using so the
correct conversion is used.

Joint Mapping Tool Kit (JMTK)

The government for use in map and symbol display provides IMTK map manipulation and display
software. The Joint Mapping Toolkit (JMTK) is National Imagery and Mapping Agency (NIMA)
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support software for Mapping, Charting, Geodesy and Imagery (MCG&I) in the Global Command
and Control System (GCCS). JMTK provides the basic capability to import and visualize user
data over map and image backgrounds, embedded within user mission applications, making the
results interoperable. These commercial solutions can provide more robust analysis, image
manipulation, and terrain visualization. Linked to JMTK, the results of these analyses remain
interoperable when shared with other users and mission applications. The JMTK functionality
includes Symbol Generation (using MIL-STD 2525 symbols and software developed by the Army
Space Program Office), and the ability to utilize standard NIMA digital map products.

ARC Digitized Raster Graphics (ARDG)

ARC Digitized Raster Graphics (ADRG) are maps that are actually 24-bit images in a special
format, which are distributed on Compact Disks. The National Imagery and Mapping Agency
(NIMA) in the United States originally produced the ADRG maps. The ARC system divides each
hemisphere into nine zones of ten degrees of latitude to minimize distortion. The ADRG uses a
rectangular coordinate projection based on the datum of the World Geodetic System 1984
(WGS84). The primary sources are conventional map sheets dated from 1984 to 1991, based on
the National Topographic System (NTS). The geographic data sets made by scanning these
maps are then presented as distribution rectangles. Each distribution rectangle may contain one
or more data sets. The group of distribution rectangles in a series at a specific scale is the
equivalent of a seamless world database of geospatial raster data in which each pixel has a
distinct geographic location (georeferenced data). The main purpose of these data is to serve as
a display background.

NOTE

Raster Maps, when compared to vector maps, are suitable for special use.
For example, when you want to explore into features not covered in vector
maps, such as vegetation, mountain top names, labels on maps and
others. Raster data is a rectangular picture of something made up of many
tiny colored dots which, when viewed together, looks like a smooth,
cohesive picture to the human eye. Television and computer screens are
good examples of a raster of colored dots, which define a picture for your
eye. A raster format product is sometimes considered a dumb map
because it is a picture of a map. NIMA produces several raster data
formats; ARC Digitized Raster Graphics (ADRG), Compressed ARC
Digitized Raster Graphics (CADRG), and Controlled Image Base (CIB) are
the most common.

The Controlled Image Base (CIB)

The Controlled Image Base (CIB) is a dataset of orthonormalized and rectified grayscale images.
CIB data are derived directly from digital images, and are compressed and reformatted to
conform to the RPF Standard. These maps are also distributed on CDs that are avail able for use
with the system.

Common Message Processor

The Common Message Processor is government furnished software that provides support for
freetext messaging, and creation and reception of other message types that are displayed for
operator review. When a version of AFATDS software gets released for use, the following CD
ROMs are also provided.

Joint Master Unit List (JMUL)

The JMUL is a COE segment that is loaded onto the AFATDS computer using the COE segment
installer, which is much like the Add/Remove Programs utility on an MS Windows PC. The JMUL
acts as an “address book” of units and systems with which the AFATDS operates. Because
AFATDS must communicate with a number of external systems that use several different
protocols, and because each protocol uses a different method of identifying a unit, the master unit
list acts as “look-up” to compare received information and determine to which that information
applies. Since a large portion of the US Armed Forces organization remains constant, an
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updated master unit list of joint and coalition forces is created for each AFATDS version. This is
the JMUL. When the JMUL is loaded onto AFATDS, it becomes a Master Unit List (MUL) for the

system.
Maintenance and Utilities:

The Maintenance and Utilities CDROM is the only software provided that is classified above the
UNCLASS level. Maintenance and Utilities is classified as a secret segment because it provides
Joint Munitions Effectiveness Manuals (JMEM) and Loadable Munitions Modules (LMM). JMEM
data provides munitions effectiveness data used by AFATDS and LMMs provide missile
effectiveness, flight characteristics and data for automatic construction of air space hazard areas
associated with employment of missiles.

Effects Management Tool (EMT)

The EMT software provides the ability to access data from the AFATDS current situation
database. EMT also allows the movement of units and creation of FSCMs and graphics on the
AFATDS. EMT has additional capability that is not resident in the AFATDS application such as
import and export of database information (FSCM’s, targets data, etc) to MS Excel spreadsheets
and processing capability such as checks of fire missions and targets against the no strike list.

The Effects Management Tool (EMT) is a client for the Advanced Field Artillery Tactical Data
System (AFATDS) jointly developed by the US Army and the US Marine Corps. The EMT serves
as an intuitive and easy to use display and entry device for the Host AFATDS to which it is
connected. EMT reads information from the AFATDS database and shows this information on a
digital map display. This allows the display of unit symbols, battlefield geometries, fire support
coordination measures, and target symbols. The EMT allows for data ‘drill down’ on the objects to
interrogate them and display information maintained within AFATDS. EMT also displays the firing
vectors for active missions being processed in AFATDS. The client operator performs specific
tasks and is ‘shielded’ from the other AFATDS functions and AFATDS administration.

EMT collectively consists of a number of software applications that interoperate to provide EMT
Functionality. The EMT application is written primarily using the java programming language.
The EMT is platform independent and will run on a number of Operating Systems including
Windows NT 4.0 SP6a, Windows 2000 SP2, and Sun Solaris. The EMT also makes use of some
XML components.

Map Display Applications

The EMT Application does not independently display information on a computer screen, but
rather makes use of one of two map display applications. These applications are the Joint
Mapping Tool Kit, which was previously mentioned and the Command and Control PC, below.

Command and Control For The C2PC

Command And Control For The PC (C2PC): Developed by Northrop Grumman for the US Marine
Corps since 1995, Command & Control for the PC (C2PC) is fundamental to systems transmitting
or receiving the Common Tactical Picture (CTP) or Common Operational Picture (COP) in a
Windows environment. It is an optional network client solution for systems based on Northrop
Grumman’s COTS C4l product, ICS. When operating with C2PC, EMT does not share data with
the C2PC network, but injects data directly into the C2PC map display. This allows C2PC data
and EMT data to be displayed on the same map display at the same time.

AFATDS Application Server (AAS) Emulator

The AAS emulator provides a training utility by emulating a connection to an AFATDS v6.3.1
AAS. This allows for the EMT to run on a computer without being connected to an actual
AFATDS. The user will be able to perform functions like: Initiate Fire Mission, Create/Edit/Delete
Geometry, Move Units, and View Information.

AFATDS Versions
The following versions of AFATDS software have been fielded or released for testing

Version 6.3.2.0 is the latest release version and scheduled for release in December 2003.
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Any versions in the series Version 8.14 (followed by a letter, e.g., 8.14G) are developmental
engineer builds. These sometimes are found in active units as residuals of testing. Under no

circumstances should an engineer build be used for actual operations beyond authorized and
controlled testing.

Version 6.3.1.0, sometimes referred to as A99+, is to be replaced by version 6.3.2.0.
NOTE

A unit that uses one version of software cannot effectively and reliably
interoperate with units using another version. A stopgap measure is to
have the AFATDS that interface, using different versions, to define the
system type of the opposite AFATDS as a package 11 system (a system
that employs package 11 messages for information exchange). This
allows the exchange of information but to a much lesser degree than
normally expected between AFATDS.
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OPERATIONAL ASPECTS

Guidance

In AFATDS commanders may put in their preferences regarding a multitude of situations, from
what type of munitions to use on what type of targets, to what units should be used in what
situations. These and many other preferences are considered commanders guidance. Even
though the plural of one item of guidance is still guidance, the term in Fire Support circles for this
set of preferences is called Guidances. Some Guidances are merely record keeping tools, others
allow the information to be placed into a written plan (e.g., an OPORD or FS Annex) and others
are used when processing fire missions to determine HOW and WHEN to attack targets.

In AFATDS, there are Target Categories. Within each target category there are Target Types.
Many systems, such as IFSAS, call these the Target Type and Subtype instead. Many of the
guidances in AFATDS will allow you to specify guidance for each individual target type. When a
call for fire is received at AFATDS for processing, the target type of the mission is used to find
what specific guidance has been given for that target type.

Of those guidances used in processing fire missions, some are called Filters. These filter
guidances determine if the target should be shot or not. For example, if the target is a duplicate of
another target, we need to eliminate the second call for fire; the Target Duplication guidance will
filter these types of targets out.

Some guidances are used to determine how or when to shoot the target. They allow targets to be
prioritized relative to one another as well as provide information on what kinds and volume of
munitions or what effects to use on the target.

Other guidances are considered Preferences. For these, the entry you make will not necessarily
be the solution provided for a fire mission as other information may be taken into account as well.
For instance, when shooting a certain target type, your preference may be to shoot it with DPICM,
TIME, and 2 PLT volleys. But if no units have DPICM, other shell/fuze combinations will be
chosen. If available, alternatives will be given, but your preference may be ranked higher than
other alternatives and may in fact be the suggested option. Preference guidances allow blank
entries to be made; for these guidances, blank entries just mean No Preference.

Fire Mission Processing

First of all AFATDS receives fire missions as calls for fire, Tactical Air Requests (TARS) or Air
Target Intelligence (ATI) information. These usually arrive at an AFATDS workstation digitally,
through a network, as Fire Requests (FRs). The operator responding to a voice call for fire may
also input calls for fire manually. Once it’s in the system, it's a Fire Mission.

Tactical Air Requests (TAR): TLDHS and some other systems can send a TAR message to
AFATDS for an immediate Close Air Support (CAS) request. This message is processed in the
same manner as a call for fire message.
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@Observer Locates Target with Laser
@ Digital Mission to AFATDS

@Target Displayed & Analyzed @

@ Digital Mission to.Weapon -
Observer Notified

@ Weapon Fires/& Reports
@Observer Notified

Figure 2. The Digital Mission

Artillery Target Intelligence (ATI): ATl messages provide target information. Theses are
processed by AFATDS based on commander’s guidance. Commander’s guidance provide a rule
set that define, among other things, how to process ATl data. ATI data is handled using the
following process:

The ATI target is checked against the currently effective target selection standards (TSS)
guidance, if the operator has selected that option for processing. If the target is not sufficiently
accurately located or too old, the target data is stored in the AFATDS Suspect Target List for
potential refinement by future, supporting reports. If the target passes TSS guidance checks, the
target is further evaluated.

Upon reception of the Fire Request, AFATDS will store the data, determine the mission
precedence (priority), determine the Battle Area (the geometry where the target is located), and
check and react to additional data related to certain missions. Those missions are Quick Smoke
missions, Time on Target (TOT) missions, and Moving Target Missions.For targets passing the
TSS check, the target type is next checked against the high-payoff target list. If the target type is
not a high payoff target, the target is stored in the AFATDS inactive target list an no further
automatic processing is performed except to perhaps purge the data when it is too old to be valid
(if such purging is “turned-on” by the AFATDS operator).

If the target type is found on the High Payoff Target (HPT) list, the target is further processed to
determine when it should be attacked as indicated on the HPT list. Planned Targets are added to
the AFATDS Planned target list for future inclusion into fire plans. Targets designated to be
attacked “as acquired” or “immediately” become unobserved fire missions.

Target Filtering

Target data is checked during fire mission processing to ensure it is actually valid as a fire
mission. Failing a filtering check causes AFATDS to evaluate fire support and produce solutions
but causes AFATDS to recommend denying the mission. Final Protective Fires (FPF),
Copperhead priority targets, registration missions and missions employing special munitions such
as FASCAM always pass filter checks. (AFATDS allows an override of any of its
recommendations.) The following checks apply.
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Target Selection Standards

This check is “turned-off” by default but can be enabled by the operator. If enabled, this check
requires the target meet accuracy (target location error) and age checks to be valid. The Target
Location Error (TLE) checks if the TLE is less than or equal to the maximum acceptable TLE.
The sensor’s TLE is extracted from Detailed Unit Info or may be a default value. This is then
compared to the TLE for the target type. Max Report Age checks to see if the age of the report is
less than or equal to the maximum acceptable age for the given target type. The Current Date
‘Time Group (DTG) is compared to the DTG when the target was acquired and then to the Max
Report Age for the target type. Comparing the information in the sensor’s detailed unit
information window checks reliability. The check determines if the sensor is reliable for the target
type. If a target fails the TSS, it is sent to the suspect target list.

Target Duplication

This check evaluates the target against other fire missions currently active to determine if the
target is close enough and sufficiently similar to be classified as a duplicate of the established fire
mission. (A discussion of target duplication can be found in Appendix H under Suspect Target
Processing.)

Target Build-up

This check examines the target against target build-up area geometry in the database. The
objective of the geometry is to cause mission to be denied until a desired density of targets has
appeared in the build-up area.

Not Later Than (NLT) Time

Each processed target has a decay time applied based on the target type. Target decay time is
established, by target type, by the AFATDS operator in guidance. The decay time is added to the
time the target was acquired to determine a NLT time. The target must be able to be engaged
prior to the expiration of the NLT time.

AFATDS ensures that a Target Number is assigned. If mission was received (or initiated from the
keyboard) with a target number, the target number will remain with the target. If the mission was
received (or initiated from the keyboard) without a target number, AFATDS will assign a target
number from its own target block. The Excluded target filter check compares the target type of
the current target to the Excluded Target guidance (TMM) to see if the target type has been
excluded. If the target type is excluded, the mission is “flagged” and processing continues with
the next filter check.

If the CURRENT target lies in Target Build-Up Geometry, the target will fail this filter if the
strength of this target and the sum of previous targets (of the same type found in this geometry) is
less than the “trigger” established in the Geometry. IEW Routing determines if the target must be
coordinated with IEW (ASAS) prior to attack. It also checks the target type with the Target
Management Matrix (TMM) to determine if this target type is flagged for IEW routing. If IEW is
checked on any target in the TMM, an entry in Mission Info Routing must be made to provide
AFATDS with the unit ID that the coordination request will be forwarded to. There is a check for
preferred Mission Routing. If the mission is an Immediate Suppression or Immediate Smoke, the
mission is checked against Mission Routing guidance to determine the ID of a unit if specified and
capable. This guidance speeds the attack of these targets by bypassing processing at
intermediate OPFACs.

As each mission is processed, AFATDS calculates and assigns a Mission Value to that mission
between 0 and 100. The value is used to rank order the missions in queue and determine which
fire support system is used to attack that particular target.

The systems uses four separate target attributes to determine the values which are weighted and
combined to determine the overall mission priority. The values are as follows in Figure 3:

10
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(Greatest HVT LIST window value) 4 (TMM window HPT value) Target Type Value

5 " for High Payoff Targeis
(HVT LIST window value) ___ Target Type Value
) " for non High Pavoff Targets

100 x [(Value of POF rank + 1) - POF Rank of the originator]
Sum of all POF ranks in the Mission Prioritization window

— POF Value

100 x [(# of TAI ranks + 1) - TAT rank if tgt plots in TAI geometry]
Sum of all TAI ranks in the Mission Pnoritizaton window

— TAI Value

On-Call Value is always zero (0) unless the “on-call targets have higher priority™ box
is checked on Mission Prionitization window.

If the box is checked and the target is an On-Call target. the value = 100

If the box is checked and the target is not an OnCall target, the value = 0

Figure 3. Calculating Inputs for Fire Mission Value

Weights are assigned, in the Mission Prioritization window. The value of each weight is used as
a multiplier to the value as calculated in Figure 3. The values are added together. The result is
the Fire Mission Value.

{Target Type Value) x (Target Tvpe Weight) =7
(TAT Value) x (TAT Weight) =

(POF Value) x (POF Weight) = ¥

{(On-Call Value) x (On-Call Weight) =7

Fire Mission Value =7

Figure 4. Calculating Fire Mission Value

AFATDS will then assign an “Operational Until Time” for the mission. The Operational Until time
is determined by adding the Target Decay Time guidance for the mission target type to the DTG
that the mission was received (or initiated from the keyboard). If the target is not attacked within
this “window of time”, the target will “time out” and AFATDS will recommend that the mission be
denied. A Fire Support Coordination Measures (FSCM) check determines if there is a need for
coordination of the fire mission. The Fire Support Buffer Distance guidance is applied to the
target during this step.

3.2.6 Attack Analysis

Once a target passes all of the filters and checks in target processing, Attack Analysis begins.
There are three (3) levels of Attack Analysis. The level used on the target is dependent upon
which level of Attack Analysis the OPFAC utilizes. Detailed Attack Analysis is the default level
the system uses if your OPFAC is the FA CP/FDC (BTRY/PLT). Itis also the most complex
analysis performed and requires complete Fire Unit information. An OPFAC utilizing Detailed

11
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Attack Analysis must have up to date information on all fire units considered. In Detailed Attack
Analysis, AFATDS looks at individual fire units to make an assessment of their capability to attack
the target (either as a single unit or as part of a massing option). The system checks to
determine what fire units are available for consideration. It adds these to the Available Unit List.
Once available units are identified, it further refines the list to the available fire units meeting
capability criteria. The capable units are added to the Working Unit List. From the Working Units
List, the system will eliminate the selection of units, which are not capable of supporting the
mission due to location, lack of capable munitions, not being in range, etc.

The system will then develop attack options by pairing capable working units with munitions. A
capable option is sought by determining if the unit has capable munitions, could meet the
response time, effects requirements, response time, and has enough of the right munitions to
perform the mission. If a capable option is found, AFATDS stops attack option development and
makes no more passes through to find available options. When more than one capable attack
option is generated as a result of a check, the options is ranked per the Attack Option Ranking
Criteria. Those criteria can be operator specified according to Fire Support System Tasks,
Mission Characteristics, the Unit Load, and Shortest Range Capable Munitions.

As the system makes the first pass, it may find that there are no capable options. It will then go
back through the process looking for new pairings. It will continue that process until it finds a
capable attack option or has exhausted all possibilities. AFATDS provides the option to interrupt
mission processing after attack options are ranked, if the mission meets currently established
intervention criteria. This permits the operator to review target processing and attack option-
processing results and either accepts the processing actions specified in the recommendation or
select an alternative action. The Unit Attack Analysis level is designed primarily for units that are
FA CP/FDC's (Arty Regts/BN FDC) that command FA CP/FDC’s (BTRY/PLT)). This level does
not require complete FU info but does require “Unit Roll-Up” information. In the past, all FA
CP/FDC'’s performed Detailed Attack Analysis on all fire missions. This created a duplication of
effort to perform Detailed Attack Analysis at all FA CP/FDC’s. In order to help streamline the
process and eliminate the effort duplication, Unit Attack Analysis was created. It is based on the
concept that FA CP/FDC'’s that control fire units would still perform Detailed Attack Analysis. FA
CP/FDC'’s that control FA CP/FDC’s will now perform Unit Attack Analysis.

An OPFAC utilizing Unit Attack Analysis does not need detailed unit data of the guns in his
database. What is required is the number of guns ready to fire per unit (i.e. 6 guns ready to fire).
Instead, the subordinate FA CP/FDC to the OPFAC utilizing Unit Attack Analysis transmits a “unit
roll-up”. This “Unit Roll-Up” provides enough information to the OPFAC to perform Unit Attack
Analysis.

In performing Unit Attack Analysis, AFATDS looks for supporting or subordinate FA CP/FDC'’s
and fire units. Those supporting or subordinate Fire Units will be analyzed using Detailed attack
analysis and the Subordinate FA CP/FDC'’s will be analyzed using Unit Attack Analysis. Unit
Attack Analysis is similar to Detailed except for the way that units are selected. Only Subordinate
FA CP/FDC'’s are analyzed with Unit Attack AnalysisThe FA CP/FDC's are determined capable if
all of the following conditions exist:

The FA CP/FDC's roll-up data has at least one range fan that covers the target.

The FA CP/FDC'’s response time and current time is before the NLT/Operational time for
the target.

The FA CP/FDC is not saturated with missions from your OPFAC.

The Mission Cutoff value (Mission Prioritization guidance) must be met or exceeded by
the current missions assigned Mission Value.

The FA CP/FDC must have the specified munitions on hand (per ammo summary data
in the CP Ammunition Roll-Up).

The selected munitions cannot be restricted in the FS Tasks Matrix.

The FS System Attack Analysis level is the least complex and is designed primarily for all
FSE/FSCC's. This level is the default level of Attack Analysis if the OPFAC is an FSE/FSCC and
also helps speed processing.

12
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A Fire Support System is capable when the following conditions exist:
A Unit ID is entered in the FS System Attack Parameters for the given FS System.
The target is within the range area specified for the FS System.

The FS System response time and current time is less than the NLT/Operational time of
the target.

The number of missions that you have sent to the unit ID is less than the saturation level
specified for that system in the Attack Parameters Guidance. The Mission Cutoff value
(Mission Prioritization guidance) must be met or exceeded by the current missions
assigned Mission Value.

System and tested munitions cannot be restricted in the FS Tasks Matrix or FS
Munitions Restrictions.

Unit/Munitions pairings in FS System Attack Analysis are the same as in Detailed and
Unit Attack Analysis.

13
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HARDWARE

The CCU2 is a ruggedized computer that combines all components into a single cabinet. The
CCU2 is fielded to both the USMC and US Army and is found in shipboard Supporting Arms
Coordination Center (SACC) configurations. All AFATDS versions since A98 are supported on
the CCU2.

The Tadpole is a UNIX laptop that is supported beginning with AFATDS version 6.3.2.0 and
newer. This provides the compact size of a laptop. It should be noted that CCU2 and Tadpole
software are not interchangeable.

System Specifics

Fielded systems hardware overview -TBD

Power specifics - TBD

Available Media for CCU

Only a Floppy and a fashcard come with a CCU2
Available Media for Tadpole

Flash Key -TBD

Read/Wright CD -TBD
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INFORMATION MANAGEMENT

The AFATDS database is blank when software is loaded. The database is normally constructed
prior to operations. At a minimum, the following data needs to be entered:

Minimum Database Entries

Map Setup Establishes the focus of the map, its scale and what overlays (data filtering) are used
to display units, targets, etc. A default overlay called SOP can be used, though operators should
tailor more detailed filtering.

Map Mod The Map Mod establishes an area within which short UTM coordinates can be entered
and establishes the map datum for conversion of coordinates.

Own Unit Data The data of the local unit is entered. This data is transmitted to other systems
during operations to assist in creation and maintenance of a common operational picture (COP).

Communications Configuration contains network information as well as routing and address
information for the units with which the local AFATDS communicates.

Target Decay Guidance Though AFATDS supports humerous commander’s guidance, the
minimum required to process fire support is called Target Decay Guidance. This guidance
provides a number of minutes after acquisition that a target remains valid. The guidance defaults
to 0 minutes, requiring an entry by the AFATDS operator.

Target Number Block The AFATDS requires a block of NATO-type target numbers for the
processing of target data and fire missions. These are assigned to any target data entered or
received digitally and not already assigned a target number.

Master Unit List (MUL)

Master Unit List Capabilities: While targets are the focus of operations from a broad perspective,
the Master Unit List (MUL) is information foundation for AFATDS operations. It starts out on a CD
provided with the other software as the Joint Master Unit List (JMUL). Once loaded onto the
hardware, it is the MUL. The MUL is the holder of all unit information. This includes enemy units
as well. Before a unit can exist in a situation, whether it is “Current” or a “Planned”, the unit must
first exist in the Master Unit List. The MUL is also used to perform a variety of communication
functions, such as managing network-related communications parameters, and supporting
communications-related display screens associated with the Comm. Administrator duty.

The Master Unit List (MUL) supports the processes of the current or planned situations for
AFATDS databases. This provides the capabilities to maintain information of friendly units;
maintain information of Enemy units; coordinate the development and approval of friendly unit
movement orders; maintain Class Il and Class VIl summary data (AFATDS/CMP messages);
create sensor task orders; maintain unit characteristics data; generate reports; provide graphical
display of the unit information; display unit symbols on the screen display; provide an operator
interface to create and maintain this information. The MUL interfaces with other processes to
provide for the automatic distribution of this information to other units.

The MUL controls and monitors external communications based on the units in the list. During
startup, it creates or updates a “Preconfigured LAN” subnet if a configured and enabled
motherboard LAN is detected. During startup, it updates routes contained in the current
communications configuration with Current Situation units via the “Preconfigured LAN” subnet
using C2R and DNS data.

AFATDS OPFACs may Start and Initialize their systems with a database that includes the Master
Unit List (MUL) in order to perform the selection and use of the units within the list. A second
option is to power-up the system with absolutely no database information and to create a MUL
with the preferred unit information. With the second option the AFATDS would be activated using
a NULL database.

In AFATDS data is stored using the Unit Number assigned instead of Unit ID. This allows
OPFACSs to exchange Unit data correctly without requiring the Unit IDs to be displayed exactly
alike at both OPFACs. On the other hand, it REQUIRES Unit Numbers to be the same between
ALL AFATDS OPFACs which will exchange Unit data
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AFATDS SECURITY

Passwords

The Information Assurance Security Officer (IASO) has the responsibility for management of
passwords. Passwords are required as a user validation function. Passwords are issued by the
IASO to each authorized user for use by that individual user and no other. AFATDS will initially
be fielded with a default password to allow a designated the IASO to initially logon and thereafter
establish user accounts. Sharing of passwords and otherwise divulging a private password to
another user that is not authorized its use, as assigned by the IASO, is a serious breach of
security. AFATDS Client/User creation, privilege assignment, and password control is
determined the AFATDS System Administrator.

COE Security Administrator Functionality

Security Administrator functionality provides the ability for authorized users to create, delete, and
maintain user accounts and groups, as well as define profiles that provide users with easy access
to the executables and icons they need to perform their duties.

Profiles

A profile provides a mechanism by which a Security Administrator can group sets of users, often
by their job responsibilities. Rather than assigning each user a list of applications they are
allowed to access, the Security Administrator can define a profile that provides convenient access
to a series of applications, and then assign users to one or more profiles. For example, the
Security Administrator may create a profile called GCCS User, which would contain all of the
applications that a typical Global Command and Control System (GCCS) user would need to
access. The administrator could then assign this profile to one or more user accounts. Similarly,
the administrator could create a profile called Backup that would provide access to the
applications needed to perform a system backup. This profile could again be assigned to one or

more user accounts.
Account and Profile Manager (APM) Client Functionality

The APM client application provides functionality for managing user accounts, groups, profiles,
and hosts within the network. The APM client manages global account and profile information by
communicating with the APM master server within the administrative domain. In addition, the
APM client manages local account and profile information by communicating with the APM
master server running on the local machine itself.

A summary of operations that can be performed by the APM client is given below.
User Accounts
Assigning and changing an account's user name
Assigning and changing an account's password
Optionally assigning a User ID (UID) to a new account
Assigning and changing an account's default group
Assigning and changing an account's comment
Assigning and changing an account's login shell
Assigning an account's home server
Assigning and changing an account's list of group memberships
Assigning and changing an account's list of profiles
Assigning and changing an account's list of hosts

NOTE

A new user account's home directory is automatically determined by APM.
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Groups

Assigning and changing a group's name

Optionally assigning a Group ID (GID) to a new group

Assigning and changing a group’'s list of users

Assigning and changing a group's list of hosts
Profiles

Assigning and changing a profile's name

Optionally determining whether the profile is lockable with the use of a profile locking
segment

Assigning and changing the list of features available to a profile

Hosts

Assigning and changing a host's name
Assigning and changing a host's description
Assigning and changing a host's Internet Protocol (IP) address
Assigning and changing a host's alias list
Assigning and changing the function of a host
Selecting the domain to which the host belongs
6.2.3 C2 Protect Toolbox and Security Operations Suite (SOS)

The Army C2 Protect Toolbox goal is to identify and make readily available UNIX and DOS based
tools that can be easily ported and integrated into Army AIS by individual systems such as
AFATDS.

The Security Operations Suite (SOS) provides an easy method to do the administration, report
generation, report inspection, and intrusion alerts for four C2 Protect Toolbox tools. To access
the SOS tools, log in as secman. The Security Operations Suite (SOS) Main Menu provides
access each of the four C2 Protect tools: TCP Wrapper, Change Detection Tool, Swatch, and
McAfee. A brief description of the tools is provided in Table I.
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Table | Security Operations Suite (SOS) Tools

Name Description

TCP Wrapper TCP Wrapper is a Unix host application that takes the place of regular
host TCP daemon. TCP Wrapper is used to authenticate TCP and UDP
connections to hosts.

Change Detection Tool (CDT) The Change Detection Tool provides change detection on files, users,
and groups. It can detect changes to file attributes such as permissions,
ownership, modification time, and the appearance/disappearance of
files.

Simple Watcher (Swatch) Simple Watcher monitors the system audit files for refused connections
identified by TCP Wrappers and issues an alert to the operator.

McAfee Anti Virus for Hard Drives McAfee Anti Virus automatically monitors the workstation for viruses. It
also provides on-demand detection of viruses on the workstation hard

drive(s), prevents virus-infected programs from running, detects viruses
from various media, and prevents infected programs from being copied.

McAfee Anti Virus for Floppy and While not a part of the SOS, a separate McAfee Anti-Virus provides on-
OD Drives demand detection of viruses on floppy and OD drives.

6.3.3 The COE Security Bar -- Changing Workstation Security Levels

The security banner software provides a graphical display of the current security level of the
workstation upon which it is installed. The Security Level Manager segment provides a means for
a security manager (secman) to change the displayed security level of the workstation and
optionally allow that level to be temporarily overridden.

6.3.4 Unlocking a Locked Out User

To unlock users previously locked out due to too many invalid login attempts you must be logged
in as the Security Administrator (secman) and have X-Term privilege. For more detailed
information on the COE Security Bar, refer to the AV6.4.0.0 Trusted Facility Manual (TFM), MX
25-455,

6.4 AFATDS System Administrator (SA) Functionality

AFATDS System Administrator is a duty title that a user (can be the IASO) assumes upon logon
to the workstation assigned to perform the AFATDS System Administrator assignment.
Reserved privileges for the SA are:

Configuration of the OPFAC

Assignment of AFATDS Workstations

Assignment of privileges to user accounts

Assignment of privileges to client accounts (for example, EMT, FST)
Management of alerts relating to software and hardware failures
Management of the AFATDS event log

Control of specified AFATDS printer functions

AFATDS application shutdown

Management of the communication configuration defaults to the AFATDS SA but may be
assigned to another AFATDS Workstation. Due to the importance of having an administrator, the
first workstation within the OPFAC to logon will be automatically assigned AFATDS SA duties.
Once the initial AFATDS SA has been determined by default, the unit operating procedures will
describe the orderly progression of personnel capable of performing the AFATDS SA functions.
The AFATDS SA assignment can migrate to other workstations through the System/Assignment
menu selection. The following paragraph describes the assignment options.
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Definition of Roles, Assignments, Duties, and Privileges
For this discussion, these terms are defined as follows:

Role - A role will be an operational capability of an OPFAC (Fire Support Element vs.
Field Artillery CP), supported by software, and loaded when the user selects the role.
Roles will not affect the operations of the Trusted Facility software discussed in this

manual.

Assignment - A term for the software running on a workstation, the assignment will
initially be made during OPFAC configuration. The AFATDS assignments include
AFATDS System Administrator, Communications Administrator, Mission Monitor, and
Message Monitor, and they can be moved to other workstations in the OPFAC, as
required, to follow the associated movement of personnel/reorganization within the
OPFAC. The AFATDS General Operations assignment will be available at every
workstation.

Duties - A duty will be a window navigation path that will allow a user to get to a
particular set of data associated with an assignment. (A user who will be performing the
duty of System Administrator can only perform that duty at a workstation that will be
running/assigned the System Administrator software.)

Privileges - Privileges and permission will be used interchangeably to identify those
duties or navigation paths that will require permission before the navigation path can be
implemented.

User or Operator

The security features available on the AFATDS Workstation provide the commander with a
method of controlling access to the system through assignment of User IDs and passwords.
They also control access to critical functions through the use of permissions. These security
features must be consistently applied throughout the unit to maintain the levels of control and
protection provided by AFATDS.

Unauthorized Software

Procedurally, AFATDS users should not introduce any unauthorized software into the
OPFAC/IUC nor attempt to load non-AFATDS or non-COE software unless directed by
maintenance guidelines.

Communications Security

Normal AFATDS communications are conducted by secure means. Communications Security
(COMSEQC) is one of those means that includes procedures as well as equipment in providing a
degree of secrecy to communications. For example, a COMSEC device bypass is a procedure
that logically removes the cryptographic device from the configuration, due to a cryptographic
device failure, thereby allowing an authorized communication usually in an emergency situation.

For interoperability with Paladin and Multiple Launch Rocket System (MLRS) units the messages
must be exchanged as unclassified even though the system is in the classified mode. Checking
the “Send Messages Unclassified” box in the Edit Unit window does this. This should NOT be
done for any other unit types.

AFATDS Assignments and Privileges

Access to AFATDS data is controlled through the use of AFATDS assignments and privileges.
AFATDS Assignments are specific functions that can be assigned to an AFATDS Workstation. A
function that is to be performed only at one (1) AFATDS Workstation at a time is an assignment.
Table Il shows the AFATDS assignments and the menu paths that are associated with the
assignment and the AFATDS privileges required for some of the menu paths.

An AFATDS privilege restricts access to a critical menu path to the user who has been given that
privilege by the AFATDS system administrator. Privileges are tied to an assignment in that the
AFATDS application must first have the assignment turned on. Any user attempting to make a
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selection that has not been granted the privilege for that menu path will be denied access.
Privileges are assigned to a user group via the System/Administration/Client/User -
Client/User Administration - User selection. Users are then assigned to a group via the
System/Administration/Client/User - Client/User Administration - User selection.

Common AFATDS assignments are available at every workstation, however before a user can
develop or implement a plan, he must have the privilege to do so.
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Table I AFATDS Assignments and Privileges

AFATDS Operator Privilege Menu Path Selections
Assignment
System Set Time System/Administration/Set Times
Administrator Master Unit List Access System/Administration/Master Unit List
User Account Access System/Administration/Client/User
User Account Access System/Administration/Client/User - Client/User Administration - User

System/Administration/Backup Database
System/Administration/Restore Database
System/Emergency Purge

Client Account Access

System/Administration/Client/User - Client/User Administration - Client

Comm
Administrator

Communications

System/Configuration/Communications/Current
System/Configuration/Communications/Planned
C: (Communications) button on Status Line/Communications Alert List

M essage M onitor

Messages

M essages/Received Messages

M essages/M essage Log
Messages/Deferred Message Log

M essages/Configure M essages Setup

Mission Monitor

Mission Processing

Mission Processing/Mission Monitor

Mission Processing/Active Missions/Attack Option Ranking
Mission Processing/Active Missiong/Intervention Points
Mission Processing/Attack Analysis Level

Client (EMT or
FST)

View Unit Data
Update Unit data

View Geometry Data
Update Geometry Data
View Guidance Data
Update Guidance Data
View Target Data
Update Target Data

Perform Mission Commands

Perform Collaboration

Common (all
Workstations)

Plan maintenance

Situations/New Plan

Situations/Received Plans /Current - Preview
Delete (All navigation)

New Plan... (All navigation)

New Phase... (All navigation)

Display Event Log

System/System Tools/Event Log - Options/Display Filter

Implement Plan

Situations/Implement Plan

6.8 AFATDS System Administrator Client/User Administration

The AFATDS System Administrator has the capability to create, enable, define Client/User
access (permissions), and view Permissions assignment for any Client/User.

The Maximum Number of allowable Clients is selectable by the AFATDS System Administrator.
If the number of Clients is set to a lower value than the number of those connected, clients will
not be automatically disconnected, but are lost through attrition. The connected clients are listed
and the AFATDS System Administrator has the ability to select and manually disconnect any

client.
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SYSTEM Purge
Purging Data

Purging is removal of data from an Automated Information Systems (AlS), its storage devices, or
other peripheral devices with storage capacity in such a way that the data may not be
reconstructed. In order to make an AFATDS workstation operational after completion of any
purge, software will have to be reinstalled and databases restored from an archive.

The purge mechanism is part of the AFATDS Trusted Computing Base. The basic types of
purges are the following:

Volatile (power-dependent) memory - The purging of RAM and volatile cache is
accomplished by turning the computer power off, on, and then off again.

Removable media (optical, Jazz, floppy disks) - Since the optical, Jazz, and floppy drives
are not capable of being purged, they must be destroyed.

Hard disk purge - The purging mechanism of a hard disk consists of an overwrite of all
locations of the addressable memory space three times (the first time with a random
character, the second time with a specified character, the third time with the complement
of that specified character). The absence of data remnants after the purge activity is
confirmed by checking for a character other than the specified character. There are two
types of hard disk purge available (Emergency Purge and Selectable Disk Purge)
depending on the need. Emergency Purge and Selectable Disk Purge are discussed in
the following paragraphs.

Emergency Purge (Hard Disk)

The Emergency Purge only purges critical data and should only be used in time sensitive
situations, such as imminent capture of the workstation by the enemy. Emergency Purge is an
OPFAC-wide purge and requires the operator to verify intent before executing, since this action
has such serious potential for data loss. The system provides on-line menus for data erasure for
the operator. The Emergency Purge is not to be used to sanitize a hard disk for the purpose of
declassification (see Selectable Disk Purge).

Selectable Disk Purge (Hard Disk)

The Selectable Disk Purge is only available on a separate CD and is only an IASO-authorized
function. The Selectable Disk Purge procedure meets existing security requirements of AR 380-
19 for purging a hard drive for the purpose of declassification. In order to make an AFATDS
workstation operational after completion of any purge, software will have to be reinstalled and
databases restored from an archive. The IASO must verify successful completion of this process
before re-use of the affected media.

IASO Audit Log Viewer

Security Audit is a means to create a chronological record of system security related activities
that can be used to reconstruct, review, and examine a sequence of activities or events. The
IASO Audit Log Viewer is a graphical user interface that aids the user (IASO) in viewing the
events that are created in various Solaris and Security Audit files.

How to Start the IASO Audit Log Viewer

The IASO Audit Log Viewer is started from “secman” log-on and the COE Desktop. Selecting
Start/Programs/Security Functions/System Log Viewer from the menu selections starts the Audit
Log Viewer.

IASO Audit Log Viewer Window

An example of the Audit Log Viewer Window is shown in Figure 5. There are two major function
capabilities - file functions and search functions. The file functions available are Open, Delete,
and Archive. The String Search functions are Search Forward and Search Backward with
case sensitivity selectable.
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= ISSO Audit Log Viewer: 19990902143025.not_terminated.afatds6 olO
file

Search String: | |

O Case Sensitve  [Search Backward  [Search Forward |

Page |:| of 1410 |Previ0us | | Next |

Figure 5. Audit Log Viewer Window

6.10.3 File Submenus

The functions available are activated by clicking on the file submenus (see Figure 6). The “Delete”
selection is not available until the “Archive’ is performed.

file

Open >
Archive
Delete
Exit

Swatch Log
Sys Log

SU Log
Message Log
BSM

Figure 6. Audit Log Viewer File Submenus
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APPENDIX A ON LINE INFORMATION

A.1 Internet Sites Supporting Training
Online AFATDS Operator course
http://www.adtdl.army.mil/cgi-bin/atdl.dll/cm/techfd/techfd.htm

http://www.adtdl.army.mil/cgi-bin/atdl.dll/cm/afatds/afatds.htm
A.2 Program Manager/TRADOC Systems Manager Information

TRADOC System Manager Homepage http://www.army.mil/tsm_fatds/

A3 USMC Nett Homepage
http://sillwww.army.mil/lUSMC_Net/index.asp

TB 11-7025-297-10
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APPENDIX B FIRES AND EFFECTS CONSIDERATIONS

B.1 Target Processing

Target Selection Standards: Is the target accurately located, timely? Is the observer reliable in
acquiring the reported target type? Was TLE provided? If not calculate TLE or extract from unit’s
data. Failures are routed to Target Generation functions for combination & refinement.

Mission Precedence & Value: Checks Target guidance - Determines when “immediate” vs. “as
acquired” the target should be attacked. Also assign a mission value based on target parameters
and current Commander’s target guidance.

Target Duplication: Check to see if an active fire mission is currently ongoing at or near (‘near”
based on target guidance) the requested target.

Target Buildup Criteria: Check to see if a target buildup area for the reported target type has been
established, is active and, if so, check to ensure that the required quantity of targets have
previously been reported in that TBA).

Target Exclusion: Check target guidance to see if Commander’s guidance excludes attack on this
type of target.

Target Decay: Check Target Guidance to extract a “decay Time” for this target type (if not
provided in the fire request). Assesses whether the target’s dwell time has been exceeded.

B.2 Coordination Processing

FSCMs: applies doctrinal checks against coordination measure geometry to determine if
coordination is required — consider the hazard distance, command & support relationships, 3D
aspects of airspace geometry, munition maximum apogees or computed 3D rocket/missile flight
path or computed 3D ballistic trajectory for cannon munitions.

Clearance of Fires (CoF): Has the target type (based on clearance criteria guidance), Munition
(e.g. ATACMS) and point of attack (target location) has been identified in the CoF rule set as
requiring coordination?

IEW coordination. Is coordination with intelligence community required?

Blue Force Check (V6.x): Could Collateral effects of the mission place Friendlies at risk
considering the munition to be used?

Protected Area (V6.x): Any “No Strike” locations (Mosques, Embassies etc.) within Minimum safe
distance of target considering the munition to be used?

B.3 Attack Analysis
Determine Candidate Weapons
Determine candidate-firing using:
UTO relationships in the unit database
Attack guidance specified in the fire request
Eliminate restricted units (based on guidance)
Eliminate Fire Support Systems reserved for high value missions
Determine Candidate Munitions
Determine the munitions best suited for the target considering: Fire request specifications
Attack Guidance: Based on target parameters
Munitions that are most effective in causing damage to the given target type
Determine the munitions that should not be used considering:Restrictive FSCMs

Attack Guidance (consider TLE, Target size & Strength, distance from friendly troops
etc...)
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Fire unit restrictions
Determine the volume of fire to attack the target.
Quantity specified in the fire request
Effects analysis “Super Quickie 11" or the “SMART” algorithm
Analyze Fire Units

Assess each fire unit’s capability to attack and defeat the target considering: Unit's Range fan &
munition ranges.
Unit's current operational status
Unit's “Dead Space Area(s)”
Unit’s restrictions
Unit’s available weapons & on-hand, munitions
Fire unit response time - can it engage the target by the decay time (or NLT or TOT)?

Active missions already at the fire unit, considers the mission’s precedence and value to
determine if the fire unit could respond in time.

Gun-Target - trajectory & Airspace control areas
Determine Weapon Platform technical Solution
FA Cannons: Calculate the ballistic solution (including trajectory) to be used to engage the target.

The trajectory is used in clearing 3D air space and check for intervening terrain (“Down-range
masks”) between the fire unit and target location.

MLRS Launchers: calculate the rocket or missile flight path (including expected altitudes
throughout the flight path) to be used to engage the target.

The flight path is used in clearing 3D air space and check for intervening terrain (“Down-range
masks”) between the fire unit and target location. Select/Recommend Attack Options

Several options will be generated. Select the option based the following considerations (the
importance of these considerations can be changed by the operator):

Requested fire units & munitions
Guidance specified fire units & munitions
Fire unit closest to target

Shortest range munitions (e.g. don’t use Enhanced Range munitions when it's not
necessary)

Fire that is “least busy”

Fire unit with shortest response time

Units that are in “Direct Support” of my Unit
Options that use the default munitions

Operator Review (This is an optional step), based on “intervention rules” telling AFATDS
what types of missions the operator wants to see. For example, in an environment with
a high rate of missions, the operator may elect to see only those missions that were
recommended for denial or that use specific munitions (e.g. ATACMS - BAT). If no
operator review is required, the option is automatically executed. If operator review is
required, AFATDS will present the operator with all options that were considered.

While reviewing the mission, the Operator can:

Override the AFATDS solution
Select different options
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Create his own option
Deny the mission
Send the mission to another unit for further analysis
Schedule Mission

When tasking weapon systems directly - Determine when and where to transmit the mission:
Consider weapon platform capabilities: Multiple missions allowed?

Wait until NET or TOT time nears (Don’t send to weapon until necessary.)

Manage mission scheduling queue for each weapon

Transmit Mission

Create Fire order with appropriate information: Format data as required by weapon platform.

Monitor to determine if weapon received mission successfully and will comply

Manage — Monitor — Complete Mission

Direct all subsequent messaging and monitoring of status related to the mission. This includes:
Send Fire Orders to selected units
Automatic generation and distribution of Minefield data for Artillery delivered mines

Automatic transmission of coordination requests. Update the target’s “No Earlier Than”
(NET) and “No Later Than” (NLT) times if specified in the response.

Automatic Generation and transmission of the Message to observer

Automatic forwarding of weapon system actions (e.g. “Shots fired”, etc.) to the requestor
Automatic processing of subsequent adjustments (changes to aimpoint)

Automatic processing of End of mission (EOM) messages

Automatic generation and distribution of a Mission Fired Report

Automatic checking of actual effects achieved (as reported by the requestor) against the
Damage Assessment requirements for this target
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Hardware CCu2 UCuz UNIX Laptop NCU
CPU Speed 333 MHz or 440 300 MHz 500 MHz Pentium IV
MHz 1.6GHz
Internal Bus Type PCI SBus PCI
RAM Amount 1GB 1 GB or greater 2GB 256MB
SDRAM
Scsl Type UltraWide SCSI 3 | UltraWide SCSI 3 None
Dua Port Fast Wide SCSI 2
RHDD Size/Type 36 GB UltraWide | 18 GB UltraWide | 40 GB Laptop IDE 30GB
Holders 2 2 2 (different slots) 1
CDROM Speed 32X or greater 32x None None
DVD/CD-RW  |Speed None None 8x DVD ROM, 24x 4X DVD-
Read / 8x Write CD ROM
(removable)
Optical Disk Capacity None Upto 2.6 GB None None
JAZ Capacity 2.0 GB (Note 4) None None None
Flash Memory Card Capacity 64 MB or greater 64 MB or greater None None
(Note 4)
Flash Key (USB) Capacity None None 64 MB or greater None
OS & Patches AVT: Solaris2.8 | SOLPTH 4.7.0.0 SOLPTH 4.7.0.0 None Windows 2000
02/02 (Note 2) (Note 2)
Openboot Version (minimum) 3.11.2 or greater 3.11.2 or greater 4.03 or greater N/A
TCIMsExternal SCSI 2 2 0 0
SP-TCIMslInstalledin PCMCIA 2 (Note 3) 0 (Note 1) 2 (Note 3) (Note5)
(Typell) Slots
TACLINK 2000 (LAN 2 2 2 0
Interface)
3000 (PCMCIA 2 (Note 3) 0 2 (Note 3) 0
Interface)
Ethernet Native LAN 100/10 Base T 100/10 MII RJ45 100/10 Base T 100/10 Base T
LAN Board 100/10 Base T 100/10 MII RM5 100/10 Base T 100/10 Base T
USB Connectors Number 0 3 2
Printer Port Number 1

Note 1: AFATDS can support a non-standard configuration with one SP-TCIM in an internal slot.
Note 2: Operating System and Patch Level (COE Segment) as of 01 January 2003
Note 3: The combined number of TACLINK 3000 devices and SP-TCIMs cannot be more than two.

Note 4: JAZ drive or Flash Memory Card, not both at the sametime. The JAZ drive and Flash Mamory Card occupy the same bay.

Note 5: For EMT in FST mode SP-TCIMs must be used in the available PCMCIA slots.
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Protocol Media Data Encoding | Data Rates (bps)
TACFIRE |SINCGARS |FSK 1200/2400 | 600, 1200
ICOM
FSK 1300/2100 | 600, 1200
NRZ 600, 1200, 2400,
4800, 16K
Local Radio | FSK 1200/2400 | 600, 1200
FSK 1300/2100 | 600, 1200
KY-57 FSK 1200/2400 | 600, 1200
FSK 1300/2100 | 600, 1200
NRzZ 600, 1200, 2400,
4800, 16K
2 Wire FSK 1200/2400 | 600, 1200
FSK 1300/2100 | 600, 1200
CDP 8K, 16K, 32K
2 Wire FSK 1200/2400 | 600, 1200
Switched
FSK 1300/2100 | 600, 1200
4 Wire FSK 1200/2400 | 600, 1200
FSK 1300/2100 | 600, 1200
4 Wire FSK 1200/2400 | 600, 1200
Switched
FSK 1300/2100 | 600, 1200
GRA-39A FSK 1200/2400 | 600, 1200
FSK 1300/2100 | 600, 1200
GRA-6 FSK 1200/2400 | 600, 1200
FSK 1300/2100 | 600, 1200
DNVT-1035 | NRZ 600, 1200
DNVT-1042 | NRZ 600, 1200
DSVT- NRZ 600, 1200
MSRT
VMF SINCGARS |NRZ 600,1200,2400,4800,
ICOM 16K
FSK 1200/2400 | 600, 1200
FSK 1300/1700 | 600
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Protocol

Media

Data Encoding

Data Rates (bps)

FSK 1300/2100

600, 1200

FSK 1575/2425

600, 1200

Loca Radio

FSK 1200/2400

600, 1200

FSK 1300/1700

600

FSK 1300/2100

600, 1200

FSK 1575/2425

600, 1200

KY-57

NRZ

16K

FSK 1200/2400

600, 1200

FSK 1300/1700

600

FSK 1300/2100

600, 1200

FSK 1575/2425

600, 1200

KG-84A

NRZ

600, 1200

2 Wire

CDP

8K, 16K, 32K

FSK 1200/2400

600, 1200

FSK 1300/1700

600

FSK 1300/2100

600, 1200

FSK 1575/2425

600, 1200

2 Wire
Switched

FSK 1200/2400

600, 1200

FSK 1300/1700

600

FSK 1300/2100

600, 1200

FSK 1575/2425

600, 1200

4 \Wire

CDP

8K, 16K, 32K

FSK 1200/2400

600, 1200

FSK 1300/1700

600

FSK 1300/2100

600, 1200

FSK 1575/2425

600, 1200

4 Wire
Switched

FSK 1200/2400

600, 1200

FSK 1300/1700

600

FSK 1300/2100

600, 1200

FSK 1575/2425

600, 1200

GRA-39A

FSK 1200/2400

600, 1200

FSK 1300/1700

600

FSK 1300/2100

600, 1200

FSK 1575/2425

600, 1200
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Protocol Media Data Encoding | Data Rates (bps)
GRA-6 FSK 1200/2400 | 600, 1200
FSK 1300/1700 | 600
FSK 1300/2100 | 600, 1200
FSK 1575/2425 | 600, 1200
DNVT-1035 | NRzZ 600, 1200, 16K
DNVT-1042 | NRzZ 600, 1200, 16K
DSVT- NRZ 16K
MSRT
NATO SINCGARS | FSK 1575/2425 | 600,1200
ICOM
Local Radio | FSK 1575/2425 | 600,1200
KY-57 FSK 1575/2425 | 600,1200
2 Wire FSK 1575/2425 | 600,1200
2 Wire FSK 1575/2425 | 600,1200
Switched
GRA-39A FSK 1575/2425 | 600,1200
GRA-6 FSK 1575/2425 | 600,1200
EPLRS EPUU NRZ 600, 1200, 2400,
4800, 8K, 9600,
16K, 19200, 24K,
32K
CDP 600, 1200, 2400,
4800, 8K, 9600,
16K, 19200, 24K,
32K
LAN N/A N/A N/A (Approx. 10
Million)
MPN LAN | N/A N/A N/A
MCS SINCGARS |NRZ 600, 1200, 2400,
ICOM 4800, 16K
FSK 1200/2400 | 600, 1200
FSK 1300/1700 | 600
FSK 1300/2100 |1200
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Protocol Media Data Encoding | Data Rates (bps)

Local Radio | FSK 1200/2400 | 600, 1200

FSK 1300/1700 | 600

FSK 1300/2100 |1200
KY-57 NRz 16K

FSK 1200/2400 | 600, 1200

FSK 1300/1700 | 600, 1200

FSK 1300/2100 | 600, 1200
KG-84A NRZ 16K, 32K
2-Wire CDP 8K, 16K, 32K

FSK 1200/2400 | 600, 1200

FSK 1300/1700 | 600, 1200

FSK 1300/2100 | 600, 1200
2-Wire FSK 1200/2400 | 600, 1200
Switched

FSK 1300/1700 | 600, 1200

FSK 1300/2100 | 600, 1200
4 Wire CDP 8K, 16K 32K

FSK 1200/2400 | 600, 1200

FSK 1300/1700 | 600, 1200

FSK 1300/2100 | 600, 1200
4 Wire FSK 1200/2400 | 600, 1200
Switched

FSK 1300/1700 | 600, 1200

FSK 1300/2100 | 600, 1200
GRA-39A FSK 1200/2400 | 600, 1200

FSK 1300/1700 | 600

FSK 1300/2100 |1200
GRA-6 FSK 1200/2400 | 600, 1200

FSK 1300/1700 | 600

FSK 1300/2100 |1200
DNVT-1035 | NRzZ 16K, 32K
DNVT-1042 | NRzZ 16K, 32K
DSVT- NRZ 16K, 32K

MSRT
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Protocol Media Data Encoding | Data Rates (bps)
188-220A | SINCGARS |NRZ 600,1200,2400,4800,
16K, 1200N, 2400N,
4800N, 9600N
FSK 75,150,300,600,1200
188C/4202A
2 Wire CDP 16K, 32K
FSK 75,150,300,600,1200
188C/4202A
4 Wire CDP 16K, 32K
FSK 75,150,300,600,1200
188C/4202A
Analog FSK 75,150,300,600,1200
188C/4202A
KY 57 FSK 75,150,300,600,1200
188C/4202A
NRZ 16K
GDU Locd radio | N/A N/A
2 Wire N/A N/A
2Wireand |N/A N/A
radio
FCS SINCGARS |NRzZ 600, 1200, 2400,
ICOM 4800, 16K
FSK 1200/2400 | 600, 1200
FSK 1300/2100 | 600, 1200
Loca Radio | FSK 1200/2400 | 600, 1200
FSK 1300/2100 | 600, 1200
KY-57 NRZ 600, 1200, 2400,
4800, 16K
FSK 1200/2400 | 600, 1200
FSK 1300/2100 | 600, 1200
2 Wire CDP 8K, 16K 32K
FSK 1200/2400 | 600, 1200
FSK 1300/2100 | 600, 1200
2 Wire FSK 1200/2400 | 600, 1200
Switched
FSK 1300/2100 | 600, 1200
4 Wire FSK 1200/2400 | 600, 1200
FSK 1300/2100 | 600, 1200

35



TB 11-7025-297-10

Protocol Media Data Encoding | Data Rates (bps)
4 Wire FSK 1200/2400 | 600, 1200
Switched

FSK 1300/2100 | 600, 1200
GRA-39A FSK 1200/2400 | 600, 1200
FSK 1300/2100 | 600, 1200
GRA-6 FSK 1200/2400 | 600, 1200
FSK 1300/2100 | 600, 1200
DNVT-1035 | NRZ 600, 1200
DNVT-1042 | NRZ 600, 1200
DNVT- NRZ 600, 1200

MSRT
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APPENDIX E IMPORTING AND EXPORTING THE MASTER UNIT LIST

Procedure: Import or Export Master Unit List (MUL) to or from Removable data

Step Action Results/Explanation
1. Select System\AdministrationMaster Unit List. | Master Unit List window opens.
NOTE
Selecting OK at any time closes the Master Unit List window.
To perform the following Master Unit List window functions, go to the
steps below.
Export List (Step 2)
Import List (Step 7)
Create a new unit (Step 13)
Edit a unit (Step 14)
Delete a unit (Step 29)
2. Select Options\Export. Import Export Master Unit List
window opens
3. Select Archive Device with Status of Ready to
receive file.
NOTE
To remove disk after export function is complete, access Import Export
Master Unit List window, select Archive Device from which to release
disk, and select Release Disk button to eject selected disk. To refresh
Archive Device list select Refresh button.
4, Select Export. Confirm Master Unit List Export
window opens.
5. Select Export. Confirm Master Unit List Export
window closes. Import Export Master
Unit List window becomes active.
6. To perform other functions of Master Unit List
window, refer to note prior to step 2.
7. Select Options\Import. Import Export Master Unit List
window opens.
NOTE
To remove disk after import function is complete, access Import
Master Unit List window, select Archive Device from which to release
disk, and select Release Disk button to eject selected disk.
To refresh Archive Device list and clear Files list select Refresh button.
To delete an archive file from optical disk select Archive Device with
Status of Ready, select file from Files list and select Delete button.
8. Select Archive Device with status of Ready Fileslist fills with any existing archive
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Procedure: Import or Export Master Unit List (MUL) to or from Removable data

Step Action Results/Explanation

containing master unit list file to import. file names.

0. Select file Master Unit List from Fileslist.

10. Select Import.... Confirm Import window opens. This
window lists any discrepancies note
between the current lists and the list to
be imported.

11. Select Import. Confirm Import window closes.

12. To perform other functions of Master Unit List

window, refer to note prior to step 2.

13. Select New (proceed to step 16). Edit Unit window opens.

14. Select Unit ID:

15. Select Edit. Edit Unit window opens,

16. Enter Unit ID:

17. Enter AFATDS Unit Number: (0-32766).

18. Select System Type: Select System Type window opens.

19. Select system type.

20. Select OK. Select System Type window closes.
Selection appears in System Type:
field.

21. Enter Default M SE Phone Number (1-22

numeric characters).
22. Enter Default EPLRS LCN: (0-255).
23. Enter EPLRS MILID: (1-8 alphanumeric
characters).
NOTE
Legal entries for TACFIRE Alias: fields are:
Section NUMDEr ........c.cooiiiiiiie e 1 alphanumeric character
Platoon NUMDbET.........cocociiiiiiiiiee e 1 alphanumeric character
BaAttery.. oo 1 alphanumeric character
Battalion or Observer number...........ccccceevveeinneen. 2 alphanumeric
characters
Regiment/Brigade/DiviSion.............cccccveiiiveeeeennee. 3 alpha numeric characters
24. Enter TACFIRE Alias. (required for AFATDS
and TACFIRE systems, 1-8 aphanumeric
characters).
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Procedure: Import or Export Master Unit List (MUL) to or from Removable data

Step

Action Results/Explanation

NOTE
Legal entries for NATO Alias: fields are:
Section Number 1 alphanumeric character
Platoon Number 1 alphanumeric character
Battery1 alphanumeric character
Battalion or Observer number 3 alphanumeric characters

Regiment/Brigade/Division 3 alphanumeric characters

25.

Enter NATO Alias: (1-9 alphanumeric

characters.

NOTE

The fields for the ACCS Alias do not necessarily relate to an echelon.
The user will normally enter echelons, but as long as the entries match
entries at other OPFACs and are within legal limits, no other

restrictions apply. Legal entries for ACCS Alias: fields are:

1° 1-4 alphanumeric characters
2" 1-9 alphanumeric characters
3¢ 1-2 alphanumeric characters
4™ 1-5 alphanumeric characters
5 1-5 alphanumeric characters
6" 1-5 alphanumeric characters
7" 1-3 alphanumeric characters

26.

Enter ACCS Alias: (1-33 aphanumeric
characters).

27.

Select OK.

Edit Unit window closes.

28.

To perform other functions of Master Unit List
window, refer to note prior to step 2.

29.

Sdlect unit to be deleted.

30.

Sdect Delete....

Confirm Unit Delete window opens.

31

Sdect Delete.

Confirm Delete Unit window closes.

32.

To perform other functions of Master Unit List
window, refer to note prior to step 2.
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APPENDIX F JIMTK WINDOW EXPLAINED

This overview orients the leader to key windows used in AFATDS operations. Leaders familiar
with these windows will be able to better interface with the operator when looking for information
or providing guidance. More detailed explanations can be found in the Technical Manual.

This window will be explained section by section as noted with the arrows in Figure 7 below.

!”_\h.aﬂ FS0000 ﬂj]ﬁdln 45, OHH .l
Curser 147 F\I-Eu_u'-mm +EEEEEEm . Brg 0041 Ang B.77RM Mumber of Objects: -B1@67 -

— _/
V

1

| Recall Mg Arad lr;j,-:'.:r-u.u 14K Piy=20000-30000

Figure 7. The JIMTK Window

The AFATDS JIMTK map has four major menus. File, View, Map Options, and Tools. (The Tools
menu is not used in Non FDD software.)

Figure 8. Menu Options on the IMTK Map (Arrow a)

The File menu has the following sub-menus:
Save Session allows the operator to save the map session that is currently displayed.
This option will save the entire map that is displayed.
Save Map Area is used to save a specific area with a name associated to it. The
operator can select this function and when the window is displayed he will provide a
name for the specific area of the map and select OK to save that area.
Recall Map Area allows the operator to display any map area that has been previously
saved to his workstation.
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View Saved Snapshots will display any map snapshots that were created by selecting
the camera icon on the map menu bar.

Delete Saved Windows is not currently used.

Delete Saved Map Areas displays the map areas that were previously saved by the
operator.

Delete Saved Snapshots may be used to delete any map snapshots that were created

The View menu selection has four sub-menus. Coordinates, Status Bar Toggles, Reload Default

Menus, and Toggle Raise.
Coordinates sub-menu allows the operator to define the coordinate system he wishes
to use with the map. The operator changes the coordinate system to be used with the
map by selecting View / Coordinates. The drop down list will appear and the operator
will select the coordinate system and the map will switch to that coordinate system.
Coordinates will be displayed in the information bar. The information bar will be
explained later in this section.
Status Bar Toggles allows the operator to turn on / off several different features. Most
of these will not used in normal operations. If you toggle the menus off, you will not be
able to toggle them back on without shutting down and re-starting AFATDS.

Map Options menu controls many of the map properties and controls in the JIMTK Current

Situation map.
Zoom allows the operator to enlarge (zoom in) on selected areas of the map. When the
Zoom option is selected a cursor with four arrowheads will appear. Use the trackball to
move this cursor to the upper left corner of the area you want to enlarge. While holding
down the left trackball button move the trackball downward to the right. This will enlarge
the zoom window. When you have reached the desired size release the left trackball
button.

Map Properties displays the settings for the current map.

Recenter will recenter the map to the current location of the Center Marker.
Center Marker will display a center marker that the operator can move.
Center on Marker has the same effect as the recenter command.

Map Types displays a list of the map types that can be displayed if they are stored for
recall on the hard drive. The map types available are: Solid Background Map, WVS
Vector Map, WVS Plus Vector Map, RPF Map by Tiles, and RPF Map by Series.
Scale Controls allow the operator to change map scale. The scales available are, 4 x

Scale In, 3 x Scale In, 2 x Scale In, ¥2 Scale Out, 1/3 Scale Out, ¥ Scale Out, and Whole
World.

Grid Controls allow the operator to change grid line labels, lines, etc. The controls
available are, Map Grids, Grid Lines On, Grid Off, Grid Labels On, and Grid Labels Off.
Toggle Country Labels turns country name labels on and off. This feature only works if
the map files loaded have been stored with country names.

Map Color Control is used to adjust map colors. This control will display a menu that
allows the operator to change the colors that will be displayed for general map features.

Map Intensity is used to adjust the display intensity of the map.
Map Colors is similar to the Map Color Control menu.
Map Palettes and Map Layers feature is not used with RPF type maps.

Map Features menu allows the operator to access display options for stored map files.
The operator can turn on / off stored map files and features. The sub-menus available
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are, Map Features, Raster Maps, RPF Maps, VPF Features, Terrain Shading, Bottom
Contours, and Terrain Contours.

The Load CD function is used to install IMTK map products.

The Load Products function is used to load CD map products by specific type. The
menu will allow the operator to load specific map types. The available options are, Load
RPF, Load DTED, Load ADRG, and Load VPF.

12 3 4256 / ¢!

VoY vy

+) —}tﬁ:ﬁ’ﬂ”_ *

Figure 9. Interface Icons (Arrow b)

Arrow b in Figure 7 is enlarged in Figure 9. These icons are numbered in the figure and track to
the numbered explanations below. The icons allow the user to interface with the Joint Mapping
Tool Kit for simple tasks. The icons listed from left to right are:

1. Drag Zoom arrow; Allows the user to define the map area that he wants to view, once
the user clicks on the arrow the user centers the cursor on the arrow that he wishes to see and
defines its by click and hold drag to define area and release. Once released the map will display
the area defined. This function has a hotkey of F1, which will turn the cursor into the Drag Zoom
icon.

2. Recenter Icon; when selected the cursor icon will change to the icon selected, when the
operator selects an area on the map display the map will center on that location at the current
scale. F4 is the hotkey for this function.

3. Zoom: Increases map in view by a factor of 2:1. Hotkey F3. Decreases map in view by
a factor of 2:1. Hotkey F2

4. Whole world Icon: when selected takes the user to the worldview.

5. Refresh Map Icon; Refreshes the map when selected.

6. Save Screen image; When selected the Select or enter Screen Snapshot Name window

populates. The user places the cursor in the Selection portion of the window and names the
saved screen then selects OK. The area is then saved and can be viewed or deleted from the
File drop down menu under View saved Snapshots or Delete Saved snapshots.

7. Pan icons; When selected the map will move in the direction indicated by the arrow.
The map will only move to the defined outer boundary as shown in the Map inset (see Arrow2
figure 1below).

If the map is zoomed in to an area smaller than whole world, you can use the arrow buttons in the
toolbar to scroll the map further in a north, south, east, or west direction. The map will scroll
about half the distance of the current view and then stop scrolling. Click on the map, then press
F5 to recenter the map at the current pan view. This allows you to continue scrolling in the same
direction you were scrolling.

8. Center Chart Marker Icon: When selected the map display will center on the chart
marker. The Chart marker can be centered where desired by selecting the Recenter Icon,
placing it on the desired center location and then selecting the Center Chart Marker Icon.

Section C from Figure 7 is enlarged in Figure 10 and shows where the operator may determine
from what map tab he will work. System is the default tab for the JIMTK when it initializes.
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Current Tab is generated when the AFATDS program is started. All AFATDS operations will
display on the Current tab.

v v

System I |AFATDS Current I

] —»

Figure 10. Choice for Map Operations

System Tab: default tab (2) once JIMTK is started before AFATDS is initialized.
Current Tab: Tab is default display for AFATDS information.

NOTE

Users often select the System Tab then become confused when the
AFATDS tool menus are no longer displayed.

NOTE

FDD software allows the operator to make additional Map Tabs to
interface with the CTP program.

Menu interface icon; if the user selects View > Status Bar toggles > Toggle Full Screen mode
the map will only display the map inset and the Chart Tabs. All other features are hidden. To
access those features, place the cursor over the icon (item 1 in Figure 10) and right (3 button)
click it. This will display the whole list of features, including those, which were hidden as shown in
Figure 11.

i — Menus -
| Flle
View |
| Map Options |
| Tools
| ~Toolbar ltems—
| Eoom
Recenter
| 2% Scale In
| 1/2 Scale Out
Whole World
Refresh Map
| Snap Shot
Seroll Left
| Seroll Right
| Seroll Up
Scroll Down
| Center Marker

Figure 11 Menu Interface Icon menu
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At the bottom of the IMTK Map window (area 1 in Figure 7) is the Status Bar and Message Area
which have been enlarged for Figure 12. Explanations for the various parts follow below. Items 1
through 5 explain the Status Bar and items 6 through 8 explain the message area.

1 2 3 4

L Ll

Figure 12. Status Bar and Message Area

The Status Bar provides specific controls and information concerning the map currently n view
on the screen.

Drop down menu that is accessed by selecting the down arrow to the right of the information field. This
menu will contain the default value of Recall Map Area. When the operator saves a Map Area (see
arrow a, Figure 7) the “saved as” name appears in this window. Selecting the saved name area

displays the map.

Coordinate display drop down menu. Selecting the down arrow to the right of the information field
accesses the available coordinate displays. The field informs the user where the current map center is
located.

Scale drop down selection menu. Drop down menu that is accessed by selecting the down arrow to
the right of the information field. The field will display default scale selection values. This allows the
user to select specific scales vice zooming in and out.

Width Drop down menu. Drop down menu that is accessed by selecting the down arrow to the right
of the information field. The field allows the user to select varying widths and to display the widths in
Miles/Feet, NM (Nautical Miles) only, NM/Yards or KM (Kilometers)/meters.

Toggle Center Marker On/Off.

Message Area

Cursor Location. provides
Bearing from center marker data
Number of Objects displayed on Map

The Quick Pan Box located in the bottom right part of the map area (see Figure 7, item 2) has
been enlarged for Figure 13 and shows a larger picture of the map with the current view shown in
a yellow box.

Figure 13. Quick Pan Box
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This allows you to see beyond the current map view on the screen and orients you to a bigger
picture. To change the current map view to a different area within the Quick Pan Box, click
anywhere within the Quick Pan Box to recenter the yellow box around the clicked point. You may
also drag the yellow box to a different area within the Quick Pan Box to change the map view to
that area. The best way to clarify this feature is to try it out several times.
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APPENDIX G PROCEDURES FOR LOADING JMTK MAPS

Gl

Procedure for loading ADRG Maps in IMTK

Conditions: AFATDS has been initialized and is ready for operations. The Joint Mapping Tool Kit is
used to graphically display the fires situation.

Table lll. Procedure for ADRG Maps

Procedure. Load, display and manage ADRG Mapsin IMTK

Step Action Result/Explanation
1 Place ADRG map data disk into CDROM File manager window populates desktopl.
drive.
NOTE
The File Manager window will appear in the upper left of desktopl and its
menu bar will be under the AFATDS security/information bar. To move
the file manager select the file manger icon on the bottom bar of the
AFATDS, right (3 button) scroll to move and left click (1button). This will
allow the user to move the window from under the Security bar.
a Minimize the file manger window
2. From the IMTK window select Map The Select ADRG Destination File Name
Options > Load CD window populates.
NOTE
The Select ADRG Destination File Name window populates with the file
name on the CD by default.
a From the Select ADRG Destination File ADRG Loader Progress window populates and
Name window select OK. begins to load file selected. When load is
complete the window displays the following
information window “ADRG Image “filename”
L oaded”
b. From the ADRG Loader Progresswindow | The ADRG Loader Progress window closes.
select OK.
3. From the IMTK window select Map AFATDS Current: Map Properties window
Options > Map Properties. displays.
a From the AFATDS Current: Map Dropdown menu displays the following;
Properties window select the dropdown None
arrow to the right of the Overlay Map 1
ot g YNV PX Images
ry.
RPF Selected Images
b. From the Overlay Map 1 dropdown menu Dropdown menu closes; Overlay Map 1 displays
select > PX Images PX Images.
C. From the AFATDS Current: Map The AFATDS Current: Map Properties window

Properties window select OK.

closes.
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Procedure. Load, display and manage ADRG Mapsin IMTK

Step Action Result/Explanation
d. Warning window displays, select OK on Warning window closes.
window.
4, From the IMTK window select Map Raster Map controls window displays.
Options > Map Features > Raster Maps.
a From the Raster Map controls window
select al ADRG maps to be displayed.
All maps can be selected by from the
window file menu selecting Edit > Select
All
Individual Maps can be selected from the
list by holding down the Ctrl button and
clicking on each map to be displayed.
NOTE
All of the file names that were on the ADRG CD will list in the Raster Map
control window. To determine what area the map covers the user looks in
the Location field. The grid displayed is the location to the upper left
corner of the ADRG map.
b. From the Raster Map controls window The Raster Map controls window TGL window
select the On button. column changes from OFF to ON.
C. From the Raster Map controls window ADRG map/maps selected display.
select the Apply button.
NOTE
To determine if the user wants the map to be displayed the user can select
each map individually from the Raster Map Control window. Then from
the top menu select Map Options > Center on Map. This will Center the
selected Map on the AFATDS Current Tab of the JMTK. The user can
then either turn the map off in the Raster Map controls window or if it is an
area that he will operate in from the JIMTK window select File > Save Map
Area. The AFATDS current: Save As window displays in this window
(user input name) > OK. The area will then save as a Recall selection on
the Status Bar. (See arrowl, figure 1 under JMTK window overview
section above)
5. To delete maps loaded from the Raster Map | Selected maps are deleted from the Raster Map

controls window highlight the maps not
needed then select Edit > Delete Selected

Map

control window as a selection.
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Procedure. Load, display and manage ADRG Mapsin IMTK

Step Action Result/Explanation
NOTE
The number of maps selected for display should be as minimal as
possible. Each time the user moves the Current Tab in the JMTK program
the maps are redrawn. Its progress is displayed in the message area of
the JMTK window. If the user selects all maps to be displayed and is not
selective in their display this can result in the system responsiveness
being significantly impacted, remember AFATDS is a 440Mhz processor.
6. On the Bottom toolbar of the COE screen File manager window displays.
select the File Manager window that
opened in step 1.
a From the File Manager window select File | CDROM gjects and File Manager window
> Eject closes.
NOTE
If the file manager window remains open the CDROM will not work until it
is closed the Operating system believes the CDROM device to still be in
use as long as it is open. Insure users eject the CD to close the file
manager window and recover the map CD.
G.2 Procedure for loading CIB Maps in JMTK
Conditions: AFATDS has been initialized and is ready for operations. The Joint Mapping Tool
Kit is used to graphically display the fires situation; CIB map is available for load.
Table IV. CIB Maps In IMTK
Procedure. Load, display and manage CIB Mapsin IMTK
Step Action Result/Explanation
1 Place CIB map data disk into CDROM File manager window populates desktopl.
drive.
NOTE
The File Manager window will appear in the upper left of desktopl and its
menu bar will be under the AFATDS security/information bar. To move
the file manager select the file manger icon on the bottom bar of the
AFATDS, right (3 button) scroll to move and left click (1button). This will
allow the user to move the window from under the Security bar.
a Minimize the file manger window
2. From the IMTK window select Map The RPF loader window populates.
Options > Load CD
a From the RPF Loader window input the RPF L oader message popul ates

name of the CIB map to be loaded and “Copy RPF Database “filename’ to disk?
select OK.

(i.e. Fort Irwin CIB)
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Procedure. Load, display and manage CIB Mapsin IMTK

Step Action Result/Explanation
b. Select Yes on the RPF Loader window RPF Loader Progress window populates and
begins to load file selected. When load is
complete the window displays the following
information window “RPF Image “filename”
L oaded”
C. From the RPF Loader Progress window The RPF Loader Progress window closes.
select OK.
3. From the IMTK window select Map AFATDS Current: Map Properties window
Options > Map Properties. displays.
a From the AFATDS Current: Map Dropdown menu displays the following;
Properties window select the dropdown None
arrow to the right of the Overlay Map 1 PX Images
entry.
RPF Selected Images
b. From the Overlay Map 1 dropdown menu Dropdown menu closes; Overlay Map 1 displays
select > RPF Selected Images RPF Selected Images.
C. From the AFATDS Current: Map The AFATDS Current: Map Properties window
Properties window select OK. closes.
d. Warning window displays, select OK on Warning window closes.
window.
NOTE
Warning window may not display if maps of the RPF select image are
already loaded on the system
4, From the IMTK window select Map RPF Editor window displays.

Options > Map Features > RPF Maps.
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Procedure. Load, display and manage CIB Mapsin IMTK

Step

Action

Result/Explanation

From the RPF Editor window select al CIB
maps to be displayed.

All maps can be selected by from the
window file menu selecting Edit > Turn All
On

Individual Maps can be selected from the
list by holding down the Ctrl button and
clicking on each map to be displayed then
selecting the On button at the bottom left of
the RPF Editor window.

Select and Turn on maps by type is dso
available in the RPF Editor window. For
example if RPF maps of Joint Operational
Graphics (JOG) were aready loaded but
the user only wanted to turn on the CIB
maps from the RPF Editor window he
would select Edit > Select map by type >
CIB (5meters)

NOTE

All of the file names that were on the CIB CD will list in the RPF Editor window. To determine
what area the map covers the user looks in the NW Corner field. The grid displayed is the
location to the upper left corner of the CIB map.

b.

From the RPF Editor window salect the On
button.

The RPF Editor window TGL window column
changes from OFF to ON.

From the RPF Editor window select the
Apply button.

CIB map/maps selected display.

NOTE

To determine if the user wants the map to be displayed the user can select
each map individually from the RPF Editor window. Then from the top
menu select Map Options > Center on Map. This will Center the selected
Map on the AFATDS Current Tab of the JMTK. The user can then either
turn the map off in the RPF Editor window or if it is an area that he will
operate in from the JMTK window select File > Save Map Area. The
AFATDS current: Save As window displays in this window (user input
name) > OK. The area will then save as a Recall selection on the Status
Bar. (See arrowl, figure 1 under JIMTK window overview section above)

To delete maps loaded from the RPF Editor
window highlight the maps not needed then
select File > Delete.

Selected maps are deleted from the RPF Editor
window as a selection.
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Procedure. Load, display and manage CIB Mapsin IMTK

Step Action Result/Explanation

NOTE

The number of maps selected for display should be as minimal as
possible. Each time the user moves the Current Tab in the JMTK program
the maps are redrawn. Its progress is displayed in the message area of
the JMTK window. If the user selects all maps to be displayed and is not
selective in their display this can result in the system responsiveness
being significantly impacted, remember AFATDS is a 440Mhz processor.

6. On the Bottom toolbar of the COE screen File manager window displays.
select the File Manager window that
opened in step 1.
a From the File Manager window select File | CDROM gjects and File Manager window
> Eject closes.
NOTE

If the file manager window remains open the CDROM will not work until it
is closed the Operating system believes the CDROM device to still be in
use as long as it is open. Insure users eject the CD to close the file
manager window and recover the map CD.
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Appendix H TARGETING

H.1

AFATDS targeting information is accessed through the targeting folder icon on the AFATDS
Current toolbar. The Target List window allows the user to manage all targeting information. The
tree displays current targeting information and planned targeting information. The user can
reference the Target List Critical window section of the TB to familiarize himself with the window.

Key AFATDS Target Definitions:

Target Data. Target data is grid producing information received at AFATDS via a fire request
(e.g., a call for fire received from an observer or a fire mission initiated by an AFATDS operator),
or intelligence information (e.g., ATI report received from an observer). Target data is also
produced by AFATDS. For example, AFATDS uses intersecting target indicator rays to
determine a grid location, thereby generating target data.

Target. A target is target data that has passed target selection standards, and therefore, is
worthy of attacking because it meets the commander’s criteria for reliability, accuracy, and
timeliness. Targets undergo further mission processing to determine if a fire mission is executed
based on comparisons to additional targeting and attack guidance, the target’s relative value to
other targets, and if attack systems are capable of engaging the target.

Target Indicator. Target indicators represent directional information that forms a ray (line) from a
given point, in a given direction, to a derived maximum distance along which a possible enemy
target may be located. Examples of target indicators include shelling, flash, and jam strobe
reports. A target indicator will have a target type (e.g. “Artillery, Unknown”, “EW Equipment”).

Suspect Target: A suspect target is target data that has failed target selection standards and
may not be worthy of attacking because it does not meet the commander’s criteria for reliability,
accuracy or timeliness. Suspect targets are further refined until they pass target selection
standards, the operator initiates a fire mission on the suspect target, or the suspect target decays
(based on target decay guidance) and is deleted from the suspect target list.

When selected, the default list is the Current Active Target List. It is important for the leader to
understand how AFATDS manages targeting information. Target windows should be refreshed
often to ensure the user is seeing the most current data on the targets as they are viewed.

Target Lists maintained in the Target List window, Current Folder are:

Current Active Target List
Current Inactive Target List
Current Planned Target List
Current On Call Target List
Current Suspect Target List
Current ATF Target List
Named Target List

Current Active Target List: This list contains all targets that are at an intervention point (IP) or are
in the process of being fired.

This list can also contain duplicates of fires request in the case of Immediate Air Missions. If an
Immediate Air Support Request is sent up the air chain, the target information will remain in the
current active target list referenced by artillery target number.

Targets that are in this list can be have their status traced to determine what phase a fire request
is in. Messages can also be sent on active targets such as Fire, Commands, End of Mission or
Mission Fired Report. To status or send messages the user opens the target list, highlights the
active target them right clicks on it. A drop down menu will display from the drop down list the
user can select the action desired.

NOTE

Status contains a list of messages that have been transmitted or received,
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the unit that conducted the action the Type and the time. Below is a list of
the more common types seen in a Target Status window. Fire Request,
Fire Order Check Fire (used to show the initiation and cancellation of
check fire) Commands (Message to Observer, Shot, Splash, Rounds
Complete) Fire, Adjust, Record as Target, and End of mission, Mission
fired Report.

Current Inactive Target List: Contains a list of all targets that have been fired upon. Inactive
targets can also be statuses traced.

Current Planned Target List: Contains targets that have been reported as an ATI, and then a
determination is made to see if the target is a High Priority Target (HPT) and is planned. If so,
the target is added to the planned target list.

(Intervention Tabs. If a user changes precedence to Planned (i.e., P), then selects Accept
Recommendation or Send Selected, the mission will be placed on the planned target list and a
“deny” will be sent to the originator of the fire.)

Current On Call Target List: Contains a list of all targets that are in an On-Call status. Targets in
a Plan on a Planned targets in the master list are added to the On Call list when a phase is
implemented to the current situation.

Current Suspect Target List: Suspect target is target data that has failed target selection
standards and may not be worthy of attacking because it does not meet the commander’s criteria
for reliability, accuracy or timeliness. Suspect targets are further refined until they pass target
selection standards, the operator initiates a fire mission on the suspect target, or the suspect
target decays (based on target decay guidance) and is deleted from the suspect target list.

If the ATI fails the TSS guidance it will be considered a “Suspect” target and be sent to the target
generation function for further processing automatically.

The “Check Call for Fire against TSS” box must be checked in the Target Selection Standards
section of guidance’s in order to enable CFF Suspect target processing.

Current ATF Target List: Contains a list of all Amphibious Task Force target list developed in a
Plan and then activated for the current situation.

The target list is developed in a Plan; the user specifies the ATF entry (Classification, Priority and
Part number) on the More Tgt Data Tab when establishing the target. This will automatically
force the target to be placed in the ATF Target list when it is implemented into the current
situation. The ATF list allows the user to use the Status Code in the More Tgt Data Tab to track
the ATF targeting process.

Named Target List: Contains all named target list such as Prep fires, groups, series, named Air
Support List, etc.

Default ASL Current Target List: If no ASL is in the AFATDS and a request for Immediate Air is
processed the system will generate a Air Support List named, by default, ASL CURRENT as a
place holder.

If a plan exists in AFATDS a target list is maintained in a folder listed as that plans name. If one
does not exists then a placeholder for planning named SOP Phase 1 is in the tree. SOP Phase is
a placeholder and should not be used by the operator.

The Target Lists maintained in a Planned folder are:
Named Target List
MASTER Target List

Named Target List. Contains all named target list such as Prep fires, groups, series, named Air
Support List, etc.

The MASTER Target List. Is a placeholder folder for all targets that are built in a plan. If a target
is built into a group and that same target is also placed in a series then that target will be listed
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twice in the MASTER target list. This list is used by the system to track the targeting that is built
into a plan and should not be manipulated in any way by the user.

Suspect Target Processing

Suspect Targeting can be found on the AFATDS Current Toolbar under the Targets dropdown
menu > Suspect Target Processing. The operator may turn Suspect Target Processing “on” or
“off”. AFATDS defaults suspect targeting to the “off” position. Suspect target processing requires
that the unit examine the units in its database and ensure that they reflect the correct TLE
accuracy. AFATDS uses the following TLE unless otherwise specified by the operator in the unit
data.

Table V. Target Location Error

Sensor Characteristics
Sensor Type Laser On Hand Taégrgrlz.?.tgon Diret:stgr]?z(ljrlfrror
(Mils)
FO Yes 80 10
FO No 400 10
FIST Yes 80 5
FIST No 400 5
COLT Yes 80 5
COLT No 400 5
Observer not FA Yes 80 5
Observer not FA No 400 5
Air Observer Yes 270 5
Air Observer No 400 5
Naval Observer Yes 80 5
Naval Observer No 400 5
Mortar Observer Yes 80 5
Mortar Observer No 400 5
ANGLICO Yes 80 5
ANGLICO No 400 5
AFAC Yes 270 5
AFAC No 400 5
FCT Yes 270 5
FCT No 400 5
Radar AN/TPQ 36 N/A 1ooor 91;”’ of 1
0,
Radar AN/TPQ 37 N/A 90 Orrag;eﬁ’ of 1
Radar JSTARS N/A 400
All Others Yes 400
All Others No 400 5

When Suspect Target Processing is turned off, all suspect targets are added to the Suspect
Target List with no further processing.

When Suspect Target Processing is turned on, AFATDS evaluates each received suspect target
against other suspect targets in an effort to combine the new suspect target with an existing
suspect target. This is done to generate a target with a better TLE and/or DTG sensed
(remember that these are the key factors in the TSS check).

Suspect target’s received while processing was off, will not be compared for target generation.
When Suspect Target Processing is turned back on, only newly received suspect targets are
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processed. If the operator feels a Suspect target on the list should be processed, opening the
edit window and closing via OK causes the suspect target to be submitted for processing.

The following considerations are applied by AFATDS when determining which targets to combine
as well as the target data for the "new” (combined) target:

Only suspect targets that have not surpassed their decay DTG are considered for
combination.

Only targets with a similar type will be considered for combination. For example, an
“Artillery, Unknown” target would not be combined with a “Building, Metal” target.

The target size, increased by the TLE, for the new and extracted suspect targets is used to
determine overlap.

If an overlap exists between the new target and a single existing target and the overlap area
meets or exceeds the operator-established percentage of overlap required, then the two targets
match. The Overlap % tells AFATDS how close two targets must be (considering the area and
TLE of each target) in order to combine them. Figure 14 shows some examples of this
comparison.

Crorlap arca Owverlap area Tampel Ste
coepanckd by TLE

Target Bz
axpanded by TLE
Cornparing a point targel with a
Comparing Circular targels rEctangular famel

Figure 14. Examples of Overlap

If multiple overlaps exists between the new suspect target and two or more existing suspect
targets and each overlap area meets or exceeds the operator established percentage of overlap
required, then the following rules apply:

The suspect target with the greater degree of similarity to the new suspect target is combined
with the new suspect target.

If the degree of similarity is the same, the suspect target with the greater degree of overlap with
the new suspect target is combined with the new suspect target

Creriap Arcas

i
e
arace
AT, T
P mLagod TRl

Example of new amgel overapping
bwo exsing lamets

Figure 15. Overlapping Two Targets With a Third Target

When two targets are combined, the new target is sent to TSS for further processing. Both of the
“parent” targets (the two that were combined) are removed from the suspect target list.

Targets are matched first by similarity of target type. If the received suspect target matches a
suspect target on the list, the targets are then checked for area overlap. The darker areas at the
right indicate the area of overlap for two circular targets and a point/rectangular target overlap. If
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either target is overlapped by the value entered in the Minimum Overlap (%): field on the Suspect
Target List window, the targets are combined and a target is generated.

The overlap percentage is computed by dividing the area of overlap by the area of the suspect
target. As an example, a circular target with a radius of 50 meters contains approximately 7854
square meters. With an overlap of 1600 square meters, the overlap would be 20% (1600 divided
by 7854).

The type, size, TLE, and location of the individual targets are used to determine those values for
the combined target. The target type of suspect target with the smallest TLE is used as the
combined target type. If the TLE's are equal, the suspect target with the most recent DTG is
used as the target type. The combined target will be circular and contain the same area as the
larger of the two suspect targets being combined. The TLE of the combined target will be the
same as the smaller of the two TLE’s of the combining targets.

Location of combined suspect targets: The location of the combined target is determined by the
distance between the center points of the suspect targets and the ratio of their TLE's. The
location of the combined target will be on a line drawn between the centers of the combining
targets. To establish the point on the line, a ratio of the target TLE to the total of the TLE's is
used. As example, if the TLE’s are equal (30 each for a total of 60) the ratio would be %2 (30/60).
The combined target center would then be half way between the two targets. In the diagram
shown, the total TLE is 100 (75 + 25). The ratio for the point target is % (75/100) so the center of
the combined target would be % of the distance between the targets from the point target. Using
the rectangular target in the same manner locates the combined target ¥4 of the distance from the
target (the same location).

Combined target
ARTY, Mad SP (121

TLEE: =29

La0mm)

Rectangular targe
ARTY, Med 5P (121 - T40mm)

[ =25

Point target
ARTY. Unknown

TLE=T75

Line between

target centers

Locaton (center) ol

combined farget

Figure 16. Locations of Combined Suspect Targets

The target strength of the combined target will be the same as the larger of the two targets
strengths of the combining targets. The degree of protection of the combined target will be the
same as the higher level of the combining targets.
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The combined target will use the target elements, countermeasures, and environment of the
combining target with the smallest TLE or most recent DTG, as applicable. If less than three are
available, data elements from the second combining target will be used as a supplement.

Suspect targets are combined two at a time. If multiple matches occur for a received suspect
target, the targets with the most similarity are combined. If the similarity is equal, the targets with
the most overlap are combined. There is a high probability that, if the combined target fails TSS
upon processing, the combined target will again match the previously matched (uncombined)
target and a combination will occur. When two suspect targets are combined, the data for the
targets (parents of combined target) is saved should the operator elects to “un-combine” the
targets. If a combined target and another suspect target are combined, the combined target
becomes one of the parents and its parent data (i.e., grandparent data of the newly combined
target) is deleted from the database.

When two suspect targets are combined, the combined target is submitted for processing. The
target is processed in the same manner as a received ATl. The combined target is not added to
the Suspect Target List window until it has failed mission processing. If a combined target was
constructed from two suspect targets that failed TSS for the same reason, the combined target
will also fail for this reason.

As example, two suspect targets that failed TLE checks are combined to form a target that has a
TLE of the suspect target with the smallest TLE. This TLE is still in excess of TSS limits and will
fail.

Managing Suspect Target Processing: The operator may specify the “Overlap %" to be used by
AFATDS when considering targets for combination. A larger percentage (like 75%) will result in
fewer, but more accurate, combinations than a smaller percentage (like 25%). As with the target
indicator list, the operator may decide to have the suspect target list purged of targets when their
“decay time” DTG is passed. To do this simply select “automatically purge” option on the suspect
target list window. Finally, the operator may see the targets on the suspect target list that were
generated by AFATDS (these will be the targets that have a “yes” in the “Combined?” column of
the list). There is an option to “uncombine” a combined target if desired.
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APPENDIX | CONTINUITY OF OPERATIONS (CONOPS)

1.1

CONOPS With AFATDS

Continuity of Operations (CONOPS) provides AFATDS the capability to perform processes where
one OPFAC assumes the critical fire mission processing functions of another OPFAC. OPFACs
must shut down temporarily to displace to new locations or shut down unexpectedly due to
equipment failure or enemy action, these situations limit the mission of the unit. The CONOPS
process is designed to allow a designated “backup” OPFAC to assume the mission-processing
role of another.

CONOPS provides the means to designate a primary and secondary backup unit for all
OPFACs in order to conduct continuous operations for any unit temporarily shutdown. This
process provides means to transfer active mission data between OPFACSs, subordinate units and
continuation of the missions when passing control to a backup unit. An automated data
distribution scheme is incorporated to keep the databases at backup OPFACs in close
conformance with their supported OPFACs’ databases. The databases must be real time
compatible and must mirror all the database information between the OPFACSs participating in the
process.

The Principal Unit is defined within the CONOPS procedures as the unit going down and
requires a backup system to continue its mission. The Principal Unit provides database updates
with other OPFACs before, during, and after the CONOPS operation.

The Backup Unit that will assume control of the Principal Unit's role will inherit all mission
processing responsibilities to include command and of the Principal’s subordinate units. The
Backup Unit also, provides database updates to all OPFACs before, during and after the
CONOPS operation.

Satellite Units are defined as those units belonging to the Principal Unit and are considered as
commanding, subordinate, supported, and supporting units. The Satellites’ input and data
exchange will be minimal however, required for a CONOPS operation to be successful.

Operational Threads for CONOPS consists of four major operational threads that must be
completed by each specified OPFAC to establish and execute the process.

CONOPS Setup is thread that describes the operator actions necessary to enter and maintain the
appropriate CONOPS information in the AFATDS database.

The Execute planned CONOPS thread describes the actions taken when a backup OPFAC
assumes control for a principal OPFAC. In a planned CONOPS transition, the Principal Unit
executes an orderly transition and shutdown procedure.

The Execute Unplanned CONOPS is completed without the participation of the Principal Unit.
Usually this situation is generated through poor communications capabilities or a catastrophic
failure on the part of the Principal Unit. The Backup Unit assumes control for the Principal Unit,
but in this case there is no opportunity for an orderly transfer of control. In an unplanned
transition, the principal shuts down suddenly and unexpectedly.

The Terminate CONOPS is the thread that describes actions taken when the Principal Unit is
ready to resume its normal mission. It describes the orderly return of control from the Backup
Unit to the Principal Unit.

In some non-AFATDS systems, only one communications plan can be stored. This is sometimes
referred to in non-AFATDS systems as the Subscriber Table or the Routing Table. In AFATDS
any number of communications plans can be stored, while only one of which can be active.
These stored plans are known as Planned Configurations, while the active one is known as the
Current Configuration. Having multiple configurations allows Continuity of Operations (CONOPS)
planning in case an OPFAC were to be lost due to movement.

Guidance contains CONOPS OPFAC backup designations for FSE/FSCC, FA CP/FDC, and Fire
Unit FDC OPFACs. The operator may manipulate this guidance in order to specify backup units
(primary and secondary) for specified OPFACs. This guidance serves as a “notebook” for the
operator. This data is information only and has no function or associated processing.
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Data distribution is the way AFATDS ensures information is the same between many different
OPFACs. This allows units processing fire missions to have correct data about subordinate units
and allows CONOPS backup units to have necessary data if they need to go into a CONOPS
mode. Distribution lists and distribution criteria are the two major parts that make up data
distribution.

A distribution list contains a unit or a group of units, which you can select to transmit
information to. When sending information about units, geometries, etc., either a destination unit
or a destination distribution list can be selected. AFATDS has seven (7) default distribution lists
with two, which are used for CONOPS operations.

The Primary CONOPS from the Primary CONOPS entered on your Unit Information. This field is
automatically populated when your unit information is completed and saved.

Secondary CONOPS from the Secondary CONOPS entered on your Unit Information. This field
is also automatically populated when your unit information is completed and saved.

When AFATDS sends summary information (either due to automatic data distribution or due to
operator “push”), AFATDS provides some special behavior. If the destination unit for the
summary data is the OPFAC that backs up your OPFAC (i.e., your primary or secondary
CONOPS unit), AFATDS will not distribute summary data to that unit.

The Backup unit does not need your summary data since it will calculate a summary (by “rolling-
up” data maintained for your subordinates in his database) for your OPFAC anytime the operator
actions for viewing or transmitting your unit data occurs. The Backup Unit should be receiving all
of the Principal Units’ subordinate’s updates thorough automatic data distribution. The
distribution criteria to let this happen must be established and maintained.

NOTE

If you are an FA CP, make sure you set your distribution criteria to send
“This Units” basic unit data, general unit data, ammunition summary, and
weapon summary to your command and supported units. This is
necessary so they can perform unit level attack analysis on your unit.

CONOPS Setup

Preliminary setup for CONOPS support is essential to success. Before an operation starts,
knowledgeable personnel must develop a plan for CONOPS support, designate CONOPS
assignments, and provide this information to all concerned. All OPFACs must then enter
CONOPS information in their respective systems in accordance with this plan. CONOPS
assignments are typically made and disseminated to AFATDS OPFACSs using the ‘CONOPS -
Unit Backups’ table, found under the Guidances/ Miscellaneous pull down menu.

CONOPS Capabilities
AFATDS stores additional CONOPS data relationships as part of unit data.

A CONOPS Checklist window provides detailed instructions to guide the operator through the
steps in the CONOPS process. The operator can amplify the instructions in the checklist with
additional text input. This allows the operator to write “reminders” to himself regarding complex
steps in executing CONOPS transitions. This is especially useful in recalling communications
setup details. This checklist is information only and the instructions are tailored to guide the
operator through Planned CONOPS, Unplanned CONOPS, and Terminate CONOPS.

Provides the capability to transmit planned communications configurations between OPFACSs. In
this way, a single OPFAC can develop comm. configurations for the CONOPS operation with
participating OPFACs and transmit the configuration, which the receiving OPFAC can readily
implement with only minor modification.

Provides the capability to automatically archive the AFATDS database at an operator specified
time interval. This assists an OPFAC, which experiences an unexpected failure in recovering
quickly with minimal data loss.
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Provides the capability for any backup OPFAC, regardless of role, to perform the same level of
attack analysis as performed by the principal OPFAC. In order for CONOPS to work properly,
any unit assuming another unit’'s mission must duplicate the mission processing functions
inherent in the “supported” and “command” relationships. The backup unit must respond to fire
requests/orders from the principal’s “supported” unit(s) and must exercise control over the
“commanded” units.

CONOPS Information

AFATDS provides a data entity (a subset of unit data) for storing CONOPS information. This
information and its data entries are accessed through the unit's Basic information and selecting
the CONOPS subset. This action displays the CONOPS Information window, which provides
operator entry of data required for CONOPS setup and execution.

The entry in the “Address Missions To” indicates whether or not a CONOPS transfer of contral is
in effect for the unit shown in the Unit ID field. The operator should become familiar with and
understand how to interpret them. These entries help to identify the phase CONOPS is currently
in. There are three (3) selectable entries used in this field.

“Principal” is the default entry, which indicates normal operations (i.e. no CONOPS is in
effect for the current time). During this phase data distribution should be setup to allow
for exchange of information between participating OPFACS. OPFAC databases must be
identical and maintained to the Current Situation to support the execution of CONOPS.

The Primary entry indicates that the unit listed in the Primary Backup field has or is
assuming control for the Principal Unit. This entry is associated with the Active Unit
Organization and Mission Routing checkboxes.

The Secondary entry indicates that the unit listed in the Secondary Backup field has, or
is assuming control for the principal unit. The Secondary Backup is an additional unit
that may be used when the Primary Backup Unit is not able to perform CONOPS

operations.

The CONOPS Information window displays two checkboxes, which enable and disable
functions within the CONOPS process. These checkboxes may be used individually or together
to achieve desired results. The checkboxes are normally defined as on/off switches.

The “Active Unit Organization” checkbox field is enabled only if the Primary or Secondary is
selected in the Address Missions To field. An entry here indicates that the unit in the “Address
Missions To” field has assumed the command and support relationships of the Principal OPFAC.

Mission Routing: Entries are “on” or “off”. This field is enabled only if Primary or Secondary is
selected in the Address Missions To field. An entry here causes the backup OPFAC to assume
the principal’s position in the mission processing chain. When the principal OPFAC performs a
planned CONOPS transition, the operator makes entries in all three fields at once (Address
Missions To, Active Unit Organization, and Mission Routing) to cause AFATDS to transmit the
principal’s active mission files to the backup OPFAC. At the backup OPFAC, simultaneous
entries in these three fields cause the backup to transmit active target list query messages to the
principal’s subordinate, higher headquarters, and supported units.

Primary Backup: The unit entered here is the designated primary backup OPFAC for the
principal, i.e. the unit listed in the Unit ID field. It is the unit that assumes control when Primary is
selected in the Address Missions To field.

Secondary Backup: The unit entered here is the designated secondary backup OPFAC for the
principal, i.e. the unit listed in the Unit ID field. It is the unit that assumes control when Secondary
is selected in the Address Missions To field.

Active Command, Active Supported: The entries in these fields are for information only, and
have no impact on processing.

Unit Backed Up (1, 2, 3): The unit entered here is the unit receiving the backup services of the
unit shown in the Unit ID field on the form. AFATDS will not allow the operator to initiate
CONOPS unless the entry in this field in the primary (secondary) unit's CONOPS data
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corresponds to the principal OPFAC initiating the CONOPS scenario. E.g., FSE MAIN (the
principal unit) wishes to initiate CONOPS with FSE TAC as the primary backup. The unit data for
FSE TAC must show FSE MAIN in one of the Unit Backed Up fields, or the FSE MAIN OPFAC
will not allow CONOPS to be initiated.

CONOPS Guidelines

Make backup assignments ‘reciprocal’ when possible, i.e. If A backs up B, then B should also
backup A.

Backup units should have similar roles and unit echelons.
Backups should have the same zone of operations and battlefield tasks as the principal.

To the extent possible, MAKE BACKUP ASSIGNMENTS HABITUAL! CONOPS is a complex
process. It requires training and rehearsal. Soldiers will be able to execute more effectively if
they work with the same unit routinely.

CONOPS Checklist

An associated communications configuration: If the CONOPS scenario in question requires
extensive changes to communications, a planned communications configuration can be built and
stored beforehand, and it's name stored with the CONOPS information. The operator will be
prompted to implement this planned comm. configuration as part of the CONOPS procedure.

A “CONOPS Checklist.” Window. This will be displayed to the operator as a new window.
AFATDS stores and displays five versions of this window, reflecting the five unique CONOPS
situations:

Initiate Planned CONOPS—Principal
Initiate Planned CONOPS—Backup
Initiate Unplanned CONOPS—Backup
Terminate CONOPS—Principal
Terminate CONOPS—Backup

It contains the following:

A list of all steps to be executed by the local OPFAC for the CONOPS scenario

Each of the steps has an associated free text field within which the operator can enter
additional text.

The checklist window has a status indicator for each step in the checklist. As the
operator completes the associated action, he enters a character in the checklist column
to show completion.

NOTE

The detailed steps necessary to Setup and Execute CONOPS in the
Planned and Unplanned operations, and the steps to terminate CONOPS
may be found in the help function of the AFATDS system. The steps may
be printed out for study away from the system.
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APPENDIX J MASTER UNIT LIST

J.1

Master Unit List Information

Unit information for the Master Unit List commonality has to be resolved at the highest possible
level to ensure that each unit is given a unique designator. Each major headquarters will have to
assign Unit Numbers to their subordinate units and provide the Unit ID (IAW military standards) to
ensure the units are correctly listed in the MUL.

The Command and Control Registry (C2R) application programs within the AFATDS software
provide ABCS Master Unit List and communications configuration data for the ABCS
components. AFATDS exchanges unit information with the JMCIS Database. AFATDS
constructs a JMCIS alias based upon the JMCIS unit identifier received on friendly and enemy
unit information between AFATDS and JMCIS. This process requires no operator intervention.
The process is automatic between the AFATDS and JMCIS databases.

AFATDS performs checks using the MUL when creating and updating the units in the current
situation. Creating or updating unit information in the current situation is checked against the
MUL in order to create a new unit or to update an existing unit to the Current Situation.

The “Options” Menu contains selections for “Importing” and “Exporting” the Master Unit List.
Import or Export of the MUL may be performed to incorporate the use of magnetic media: Floppy
disc, Flash Card, and OD/CD. The C2R Merge Tool within the AFATDS software is intended to
facilitate the identification of discrepancies between two files, providing the basis for updating of
the existing AFATDS Joint Master Unit List (JMUL). The JMUL is used to manage the data from
which the fielded AFATDS Master Unit List (MUL) is derived.

Currently the MUL and JMUL are controlled and managed by the CTSF, Ft. Hood Texas.
Military units must provide the required information to the CTSF in order to be added to the MUL.
CTSF uses an LDIF file with the C2R Merge Tool to correctly manage the MUL.

The C2R Merge Tool provides for the comparison of two government-provided LDIF files to
electronically detect/identify discrepancies between a specific subset of unit parameters.
Specifically, a “new” LDIF file is to be compared against the “old” LDIF file, which corresponds to
unit information currently contained in the JIMUL. Discrepancies identified will provide a basis for
updating of the JMUL.

The comparison criteria is defined as a subset of the values associated with each unit which is
comprised of the combination of the Role, unit name, URN, Org ID, and/or name parameters.

Discrepancies to be reported include: New Units, i.e., any unit in the “new” LDIF file for which
none of the individual parameters of the [Role, unit name, URN, Org ID, or-name] subset exist in
the “old” LDIF file. Altered Units, i.e., any unit for which there is only a partial match of
parameters of the [Role, unit name, URN, Org ID, or-name] subset that exists in both LDIF files.
Deleted Units, i.e., any unit in the “old” LDIF file for which the entire combination of parameters of
the [Role, unit name, URN, Org ID, or-name] subset does not exist in the “new” LDIF file.

NOTE

AFATDS OPFACs should not be placed in the classified mode until all of the
administrative database work is complete.  Master Unit Lists can be
Archived/Imported at any time regardless of the classification of the OPFAC. It
is important to realize though, that importing a Master Unit List will not append
to your existing list, it will replace the existing list with any differences between
the two lists being lost. Extreme care should be taken when importing a Master
Unit List to ensure that any units that are in the current situation or in any fire
support plans are represented by the same Master Unit List number that they
originally had.

Master Unit List Window allows the user to manage the listing of all units in the system. Unit data
entered and maintained includes the unit ID’s, aliases, and system type. The user can create,
edit, or delete units. Functions are also available to import the list from or export the list to an
optical disk. In order for AFATDS to operate consistently and correctly, it is critical that the
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master unit list be maintained in a consistent manner across the entire system, meaning all
AFATDS OPFACs. Under normal circumstances, the master unit list should be administrated by
a single higher headquarters and distributed to all other AFATDS equipped units via the master
unit list Export and Import selections.

mo w0 LD e B ERFDE B 1EHAR g 39
0 Owd G0 0 SEOTLH T T wimad s 1 TAT G aes

Ehoik Foiay Corsia itk [iving

s
Linainitin

Bk DE b
[ :

ol i

o A1 magie

it | [ e b B

DAPATER | e AFaTER G

W EREENFT W)

Figure 17. Accessing the MUL

To the extent that is practical, changes to the master unit list subsequent to deployment should
be minimized. Deletion of a unit from the master unit list is discouraged since database integrity
may be compromised if references to the deleted unit still exist in any database at any AFATDS
OPFAC.

NOTE

Any modifications to the Master Unit List should be avoided if possible. If
modifications are necessary, this section must be read prior to making
modifications and/or deletions. When in the current or planning situation,
modifying a Unit ID on the Master Unit List (MUL) requires that the map
must be closed (hidden) and/or the operator must exit the situation before
the change to the Basic Unit Info window will take place.

Master Unit List Filters: The Master Unit List can be filtered in several ways that will help the
operator to find specific units or types of units. This is extremely useful when the number of units
on the list is in the thousands. The list may be filtered by any combination of the following:

Master Unit List Number (To - From)
System Type(s)

Unit ID (Filters out units whose name does not contain the text you identify in each field
of the unit name. If you leave the asterisk (*) in a field, then that field will not be
considered in the filter.)

These Master Unit List filtering features may be used while performing any of the functions that
present the Master Unit list as the list to select from (Communications Configurations, New Units
etc.). Itis important to note that if the Master unit list has been filtered; the list will be presented
with the filter applied anytime it is accessed.

Units stored to the MUL

AFATDS uses a Master Unit List to store all Unit IDs, which can be used for Unit Status and
Communications.
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For each Unit ID, the Master Unit List stores a Unit Number, a Unit Identification Code (UIC), a
System Type (for example AFATDS, BCS, FIST DMD, ATHS, etc.) and optional Aliases.
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Figure 18. Edit Unit Window

In order to edit a unit in the Master Unit list, access the Edit Unit Window

Edit Unit window

Unit ID Unit #

Unit Ids: Each unit in AFATDS is assigned a Unit ID. The Unit ID is displayed on
windows and printed out on reports. It is entered in the Master Unit List as six separate
fields but is shown as one 33-character word on windows and printouts. The fields in the
Unit ID are meant to be echelon fields but you can enter anything in them you need.
Figure 2 shows the echelon and the number of characters in each field.

Division, Corps or EAC - 10 char
Brigade or Regiment - 7 char

Battalion or TF - 6 char

Battery or Company - 5 char

Platoon - 4 char

Section or Lower - 1 char

1A 1-41FA 52 DA

Unit IDs are not sent to other systems.

AFATDS Unit Number: Between AFATDS systems, the AFATDS Unit is used to
describe what unit is being updated. AFATDS uses unit numbers to store and exchange
data. If Unit X sends Unit Y data about OPS 1-37 FA, it sends data for unit number 616
(see Table 6). If at Unit Y, unit number 616 was 1 CAV DIVARTY then there would be a
mix-up of the data. Or, if at Unit Y, there was no unit number 616, then there would be
no unit for the update. This is why it is extremely important for unit numbers to be the
same between AFATDS OPFACs.

NOTE
Unit Numbers must be the same between AFATDS OPFACs for data
distribution, communications and unit status updates to work correctly.

This requires a unit at Division or Corps level to maintain a common
Master Unit List as well as any updates or changes to the Master Unit List.
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System Type: AFATDS formats and deciphers messages based on the System Type of the Unit
we are talking to. Therefore, it is very important to have the proper system type specified for the
unit.

NOTE

If the only way to talk to another unit is to set it to a wrong, but similar,
system type, something more serious is wrong either with the device or
with AFATDS. Further troubleshooting is required.

VMFE Unit Reference Number: The “VMF Unit Reference Number” must be entered when
communicating with devices that use “URNs” such as Pkgll BCS. When creating certain
“System Types” this field will be a required entry and AFATDS will present the operator with an
alert if needed. The “VMF Unit Reference Number” can be the same as the “AFATDS Unit
Number”.

Alias (TACFIRE, ACCS Alias, NATO Alias, and JMCIS Alias): For non- AFATDS systems (e.g.
TACFIRE, BCS, ABCS, etc.), an ALIAS is entered into the Master Unit List, which must be the
same as what the other system has as its unit ID (or subscriber ID).

OPS 1-37 FA 616 AFATDS O/P/S/1/37
1 BCS A 1-37 FA 603 BCS B/1/A/1/37
A 63 FA 640 AFATDS //A/I63

1 FDS A 63 FA 642 MLRS/LAN

AFATDS uses the unit number to identify units. Whenever it displays them on the screen it uses
the Unit ID. Other systems use different methods: TACFIRE systems (IFSAS, BCS, FDS, FED,
etc.) uses a subscriber ID like “B/1/A/2 /82", EPLRS uses a MILID like “FS1-79-2", etc. When
another system sends AFATDS a message, AFATDS must “translate” their unit ID into an
AFATDS unit number and unit ID. Using the “aliases” performs this action. The aliases for a unit
are entered in the Master Unit List and include the following:

Default MSE Phone Number
EPLRS MILID, TACFIRE Alias
NATO Alias

MTS Call Sign
ATCCS Alias.

For an example, suppose that the TACFIRE alias for unit “1BCS A 2-82 FA” (unit number 17) is
“B/1/A/2 /82 “. If a TACFIRE device (e.g., BCS) sends us a message about “B/1/A/2 /82 “,
AFATDS will look that up in the Master Unit List, find unit number 17, and know the message is
about the unit “1BCS A 2-82 FA”. If the TACFIRE device would have instead sent us a wrong
subscriber ID, like “ /B/1/A /282", AFATDS would have looked in the Master Unit list and not found
a matching Alias and could not have processed the message. This illustrates the importance of
having correct alias data entered in the Master Unit List.

NOTE

All units talking to non-AFATDS systems must have the correct alias
entered. The AFATDS OPFACs, which talk to these units, must have the
correct Alias entered as well. As a rule: any unit ID alias entered in a non-
AFATDS device must have the same setting in the AFATDS Master Unit
List.

Master Unit List Window Navigation: The Master Unit List (MUL) window is opened via the
System\Administration\Master Unit List selection. The Options window menu contains selections
used to open the import and export windows. New and Edit buttons open the Edit Unit window
used to create and edit unit data. The Filters button opens the Unit List Filters window. This
window allows the operator to filter the units displayed on the MUL.
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Master Unit List window functions

Display: The Master Unit List window displays the Unit ID, System Type, and Unit Number for all
units contained in the system that are selected for display. Up to 32,766 units may be contained
in the unit list. The units are displayed on pages of up to 200 units each of which 15 lines are
visible at one time. The user moves from page to page using the Previous and Next buttons.
The pages are then scrolled to view the units on that page. The user can reduce the number of
units displayed by setting filters for specific unit numbers, system type(s), and/or unit ID’s. Filters
are set by selecting the Filters button to open the Unit List Filters window. The Filtered By: field
will display the types of filters set for the display.

New: The “Master Unit List” window is used to create “New” units in the “Master Unit List”. Each
time a new unit is created the “AFATDS Unit Number” will automatically increase to the next
available number and will start from “8191”. This field can be edited to make entries.

Edit: Edit those units that have already been created

Delete: This function allows the operator to select a specific unit to be deleted from the MUL.

Command Support Relationships

There are various ways in which the Command and Supported HQ entries are used within
AFATDS.

In Attack Analysis the Command Support is used in processing a mission to determine the
available attack assets. Any directly supporting Naval Ship, Aviation, Air, and Mortar assets are
used as is any FA units in the Command chain or the Supporting chain. (The chain is found by
looking at all subordinates and all supporting units for the units listed above.

Several data distribution lists are automatically created for you based on Command HQ and
Supported HQ information in the database. These lists cannot be edited, but they are
automatically modified when you change your or your subordinates Command HQ or Supported
HQ information.

When initially developing a Schedule of Fires, the attack assets presented are found by looking
for all attack assets in your Command or Supported chain. When disseminating a Schedule of
Fires to an FA CP, only the schedules for those units, which are in his Command or Supported
chain are sent.

When viewing a unit's Summary Supply Information (POL, Equipment, Weapons or Ammo), that
unit and all units showing him as their Command HQ are displayed.

Any unsupportable targets will be sent to your OPFACs Supported HQ if you select the
“Unsupportable” button on the Intervention window.

Coordination of ZOR'’s is based on the Support HQ relationships. A mission will require
coordination with a ZOR if the observer, his Supported HQ, or the originator of the mission is not
the same as the responsible unit for the lowest echelon ZOR’s that enclose the target area of
ZOR’s is based on the Support HQ relationships. A mission will require coordination with a ZOR
if the observer, his Supported HQ, or the originator of the mission is not the same as the
responsible unit for the lowest echelon ZOR.

Priority of Fires in Mission Prioritization will be processed and assigned a Priority of Fires ranking
for Priority of Fires, or if from an Observer, Observer's Supported HQ is the originator of the
mission.

The Command Support Relationships not only enforce the unit’'s Tactical and Technical standard
operating procedures (SOP) for the battlefield but also, provide the required information and data
used by AFATDS to perform computer-based processes. The Command Support Relationships
are part of a unit's basic information. The Current Command Unit ID and Current Supported Unit
ID are two entries in the AFATDS unit information that are used in association with various
processes throughout the AFATDS system.

The Command Support Relationships play an important part of how AFATDS performs
missions, distributes information and controls supply information. Without the proper
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command and support information entered into your system, AFATDS will not operate
properly.

These relationships are entered in the General Unit Information window for units. This
information may be operator selected for input and applies to any unit in the Current
Situation. This process will display the command and/or supported units for the current
or planned situations, as indicated by the operator.

The unit data will contain all information concerning an AFATDS unit (i.e., a friendly non
firing unit, service battery, headquarters element, fire Support Element, FA CP not
directly in control of the weapons, etc.). When a friendly unit is created in the Current
Situation the command and supporting relationships, CONOPS backup units, supported
Headquarters, Command Headquarters established in the specified unit become
associated with those units selected.

For units, which control fire units the Command Support Relationships will generate
rollup data consisting of munitions status summary, and unit range fan summary
information in the Detailed Information window. For FSEs, which control fire units such
as a mortar unit, of operator entered mission saturation value and response time will be
displayed in the Detailed Information window. Command Support Relationships
generate unit information based on echelon and organization structure.

The Command Support Relationships will display the unit organizational structure to
depict either the command/or supported structure for current or on-order assignments,
for either current or planned units, based on operator selection. The higher command
and/or subordinate units will be displayed through operator selectable menus for Current
Command and Current Supported.

The Command Support Relationships will also be used when performing Mission
Processing Attack Level Analysis. Only the Unit and Detailed are affected by these

relationships.

ES System Attack Analysis allows an FSE to perform attack analysis only to the level of detail
necessary to select a FS system and get the mission to the appropriate unit for further
processing. The level of analysis is to be used primarily at an FSE OPFAC. When performing
FS system attack analysis, detailed unit information (locations, munitions status, active missions
at the unit, etc.) is not required.

The comprehensive analysis (determining actual range, determining munitions quantity to fire on
a target to cause 30% effects, etc.) is performed by the FS system selected in the fire missions’
Attack Options. When an FSE uses FS System Attack Analysis and selects FA cannons as a
system, the mission is given to the FA unit (unit that is specified to handle missions assigned to
FA) for further analysis and execution.

Unit Attack Analysis allows an OPFAC to conduct more detailed attack analysis using ‘rollup’ unit
information. This level of analysis would normally be used in higher level FA CPs (CORPS
ARTY, DIVARTY, and FA BDE). Fire units directly supporting or commanded by the OPFAC
performing the analysis are analyzed using unit data (location, munitions capabilities, operational
status, etc.) to determine if they can attack the target and achieve the specified defeat criteria.
When an intermediate FA CP exists, AFATDS simply determines if the unit (e.g. FA Brigade, DS
Battalion), based on a set of general capabilities, can attack the target.

Detailed Attack Analysis allows an OPFAC to determine and evaluate all available individual fire
units (as well as collective groupings of fire units for massing) against the given target. This level
of analysis is used in lower level FA CPs (battalions), and at FSEs (who have subordinate fire
units) or higher-level FA CPs that command or have subordinate fire units assigned. The
Detailed Attack Level Analysis uses the Rollup data associated with the Support Command
Relationships to generate firing data and fire mission related messages.

Command Support Relationships information: There are two data entries within the unit
information window that allow the AFATDS operator to input this information.

67



TB 11-7025-297-10

Current Command Unit ID is used to enter the unit who commands another unit
or the unit another unit is attached to. Basically this is your next higher echelon.
This data will also populate or update the Current Command list in the Unit
Organization window.

Current Supported Unit ID is the unit to whom another unit is DS, R, GSR or
GS. The unit to whom another AFATDS unit would send unsupportable

missions and MFRs. This is the unit that provides your unit with the fire
support functions to achieve you unit's mission.
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APPENDIX K WINDOWS

K.1 Communication/Network Windows
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Figure 19. Current Situation Menu Bar

Current Communications Configuration lcon (1): Selecting this icon on the current situation
menu bar displays the current networks window. This window allows the leader to determine
what networks the system is currently using and their status. See Figure 20.

Destination Units Icon (2): Selecting this icon on the current situation menu bar will display the
communications unit configuration window. This window allows the leader to determine what
systems the AFATDS is talking to and how it is talking to them.

1
—

f
I +# Current Networks
Options Metwork Control
Configuration: |[ian Saved: |es
. Default : :
Metwork Protocol Workstation Channel Status Route Security GQuality
1an T FOC 1-55FA |PRIMARY LAN [Enabled |N/A Secure |GREEN
PERMANENT LAN |IP FDC 1-55FA PRIMARY LAN |Disabled |No Secure
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Figure 20. Current Networks Window

K.2 Current Networks Window

The Current Network Window (Figure 20) provides the status of all means of communication
media on which the system is talking. The Configuration window displays the name of the saved
configuration. Multiple configurations can be saved and selected at any given time. The Saved
sub pane informs the user if the configuration has been saved or not.

K.3 Window drop down menus
Options:
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Network
Control

Network display section lists the names of the networks that have been built into the current
communications configuration. PERMANENT LAN and user input names are listed here.

Protocol display window (3)
- 1P, A220, 1220, IP FSTL
-  TACFIRE, AFCS, VMF, NATO, EPLRS, FCS, GDU and MCS.
NOTE

See Appendix D for Protocol supporting media and communications
settings

Workstations display window (4): displays the workstation name entered on initialization.

Channel display window (5) displays the channel that the communications media is assigned
to. Channels are dependant on what type and number of TCIM’s the system is using and what
type of media you are using. This is used to determine what channel of those available the
AFATDS is sending and receiving information from.

Status window (6) displays enabled, disabled or suspended.

Default Router window (7) displays what network in the configuration is using the default router.
TBD

Security display window (8) displays Secure or Clear.

Quality display window (9) field displays the relative quality of the network. The quality is
described by a color. The colors are Green (highest quality), Yellow (lowest quality), Red
(operational), and Black (not operational).

NOTE

The quality displayed is based on the latest transmissions and may not
reflect the current quality.
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Figure 21. Communication Unit Configuration Window

Communication Unit Configuration Window

Knowing the Communication Unit Configuration Window makes it easier to obtain the status of
units with which you are communicating. The most used two items in this window are the Send
Test Message Button and the View Test Status

The communication window has multiple Drop down menus

Options (1) allows the user to manage units in the communications, manage routes proxy's, and
monitor the FCS if the OPFAC is part of a MRLS unit.

Test Messages (2) gives the user the ability to send test messages

Sort by Routes and Proxies (3) check boxes select the units to be displayed based on the state of
their network.

Sort selections (4) buttons are used to sort the displayed units by Unit ID or Network.

Destination Unit ID (5) field displays AFATDS unit ID’s, from the MUL, with whom the OPFAC has
the intention of communicating.

System Type (6) field displays system type of the unit from the MUL.
Network (7) field displays the name of the network the unit is on.

Active Route (8) field displays the route type (Primary, Secondary, or Tertiary) and the routing
(Direct or Indirect), or Proxy. Also displayed is the state of the network as active (A) or inactive
0.
Route (9) column displays a color code to indicate active or inactive routes. Colors used are
Green (active) and Red (inactive).
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Destination Address (10) displays the units network address.
Local Address (11) displays the Address of the users AFATDS on the network it is on.

Send Test Message Button (a)
View Test Status (b)
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APPENDIX L FIRES AND EFFECTS BASIC LOGIC

Mission )
N Assign Target Target Attack
Number Processing Anaysis —
. No Intervention and
No Intervention and Recommend Den
Destination Unit is g
aweapon system Operator accepts L
+ AFATDS attack
recommendation Intervention rule Den
Schedule or elects to send point is met U
Mission themissionto a v
weapon system Operator Operator accepts
F?er. 0 Deny recommend-
EVIEW ation or electsto
Deny the mission
No Intervention and anyway
Destination Unit is Operator accepts S;Zr?;tgng:; :)?1
not aweapon system AFATDS attack request before

Transmit
Mission

e

recommendation

or electsto send selecting attack option

°

AEATDS ‘

sent to selected unit(s)

FR or OTF fire order is J

themission to a
selected OPFAC

or operator accepts
attack option
requiring coordination

Coordination Request

Figure 22. Fires And Effects Basic Logic
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